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注意事項 
請在操作使用前，首先仔細閱讀下述內容 

請將本說明書存放在安全且便於取閱的地方，以便將來隨時參閱。 
 
 

關於 AC 電源變壓器 

警告 

 本 AC 電源變壓器專為 Yamaha 電子樂器設計。請勿用作

其它用途。 
 僅限室內使用。請勿在潮濕環境中使用。 

 

注意 

 安裝設置時，請確認 AC 電源插座伸手可及。如果發生問

題或者故障，請立即斷開本樂器的電源開關，並從電源插

座中拔下 AC 電源變壓器。當 AC 電源變壓器連接到 AC
電源插座時，切記即使關閉電源開關，仍有微量電流。當

長時間不使用本樂器時，請務必將電源線插頭從壁式交流

插座中拔出。 
 
 

關於 MODX 

警告 

為了避免因觸電、短路、損傷、火災或其它危險可能導致的嚴重受傷甚至死亡，請務必遵守下列基本注意事項。

這些注意事項包括但不限於下列情況： 
 

電源/AC 電源變壓器 

 請勿將電源線放置在暖氣機附近。此外，不要過分彎折、
損傷電源線，或在其上加壓重物。 

 只能使用本樂器所規定的額定電壓。所要求的電壓被印在
本樂器的銘牌上。 

 只能使用規定的電源線/插頭(第 72 頁)。使用不適當的電
源線/插頭可能會損壞樂器或使樂器過熱。 

 定期檢查電插頭，清除插頭上積起來的髒物或灰塵。 
 

請勿打開 

 本樂器不含任何用戶可自行修理的零件。請勿打開本樂器
或試圖拆卸其內部零件或進行任何方式的改造。若出現異
常，請立即停止使用，並請有資質的 Yamaha 維修人員進
行檢修。 

 

關於潮濕的警告 

 請勿讓本樂器淋雨或在水附近及潮濕環境中使用，或將盛
有液體的容器(如花瓶、瓶子或玻璃杯)放在其上，否則可
能會導致液體濺入任何開口。如果任何液體如水滲入本樂
器，請立即切斷電源並從 AC 電源插座拔下電源線。然後
請有資質的 Yamaha 維修人員對設備進行檢修。 

 切勿用濕手插拔電源線插頭。 
 

火警 

 請勿在樂器上放置燃燒著的物體，比如蠟燭。燃燒的物體
可能會傾倒並引發火災。 

 

當意識到任何異常情況時 

 當出現以下任何一種問題時，請立即關閉電源開關並從電
源插座中拔出電源線插頭。然後請 Yamaha 維修人員進行
檢修。 

– 電源線或插頭出現磨損或損壞。 
– 散發出異常氣味或冒煙。 
– 一些物體掉入樂器中。 
– 使用樂器過程中聲音突然中斷。 
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注意 

為了避免您或周圍他人可能發生的人身傷害、樂器或財產損失，請務必遵守下列基本注意事項。這些注意事項

包括但不限於下列情況： 
 
 

電源/AC 電源變壓器 

 不要用電源分配器把樂器連接到電源插座上。否則會降低
聲音質量，或者可能使插座過熱。 

 當從本樂器或電源插座中拔出電源線插頭時，請務必抓住
插頭而不是電源線。直接拽拉電源線可能會導致損壞。 

 長時間不使用樂器時，或者在雷電風暴期間，從插座上拔
下電插頭。 

 

安放位置 

 請勿將本樂器放在不穩定的地方，否則可能會導致突然翻
倒。 

 請勿把樂器靠在牆上(允許和牆壁相距至少 3 cm/1 英
寸)，否則會引起空氣流通不足，可能使樂器過熱。 

 當運輸或移動本樂器時，請務必由兩個或兩個以上的人進
行。獨自一人搬動樂器可能損傷背部，導致其它傷害，或
者對樂器本身造成損壞。 

 搬動樂器之前，請務必拔出所有的連接電纜，以防止損壞
電纜或絆倒他人造成人身傷害。 

 設置本產品時，請確認要使用的 AC 電源插座伸手可及。
如果發生問題或者故障，請立即斷開電源開關並從電源插
座中拔下插頭。即使關閉了電源開關，仍有極少量的電流
流向本產品。預計長時間不使用本產品時，請務必將電源
線從 AC 電源插座拔出。 

連接 

 將本樂器連接到其它電子設備之前，請關閉所有設備的電
源開關。在打開或關閉所有設備的電源開關之前，請將所
有音量都調到最小。 

 務必將所有元件的音量調到最小值，並且在演奏樂器時逐
漸提高音量，以達到理想的聽覺感受。 

 

小心操作 

 請勿在樂器的間隙中插入手指或手。 
 請勿在面板或鍵盤上的間隙內插入或掉落紙張、金屬或其

他物體。否則可能會對您或他人造成人身傷害、對設備或
其它財物造成損壞，或造成操作故障。 

 請勿將身體壓在本樂器上或在其上放置重物，操作按鈕、
開關或插口時要避免過分用力。 

 請勿長時間持續在很高或不舒服的音量水平使用本樂器/
設備或耳機，否則可能會造成永久性聽力損害。若發生任
何聽力損害或耳鳴，請去看醫生。 

 

 

對由於不正當使用或擅自改造本樂器所造成的損失、數據丟失或破壞，Yamaha 不負任何責任。 

 
當不使用本樂器時，請務必關閉其電源。 
即使當[ ] (待機/開機)開關處在待機狀態(顯示屏關閉)時，仍有極少量的電流流向本樂器。 
當長時間不使用本樂器時，請務必從壁式 AC 插座上拔下電源線。 
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須知 
為避免本產品、資料或其它部件可能受到的損壞，請注意下
列事項。 

■ 操作處理 
 請勿在電視機、收音機、立體聲設備、行動電話或其他電

子設備附近使用本樂器。否則，本樂器、電視機或收音機
可能會產生噪音。本樂器連接 iPad、iPhone 或 iPod touch
使用其中的應用時，我們建議將蘋果設備上 “飛航模式” 
設置為 “打開”，以避免因通訊信號造成的噪音。 

 請勿將本樂器置於灰塵過多、搖晃較強或極寒極熱的場所
(如長時間置於直曬的日光下、取暖器附近或轎車內)，以
防止產品面板變形而導致內部元件損壞或運行不穩定。 

 請勿在樂器上放乙烯或塑料或橡膠物體，否則可能使面板
或鍵盤脫色。 

 清潔本樂器時，請使用柔軟、乾燥或略微沾濕的布。請勿
使用塗料稀釋劑、溶劑、酒精、清潔液或浸了化學物質的
抹布。 

■ 儲存資料 

 已編輯的演奏組資料 
未儲存而關閉本樂器電源時，已編輯的演奏組資料將丟
失。這種情況在電源被自動關機功能(第 19 頁)關閉時也會
發生。 

 MIDI 和系統設置 
當對應設置畫面切換到其他畫面時，將自動儲存 MIDI 設
置數據和系統設置數據。當未切換畫面而關閉本樂器電源
時，數據將丟失。因自動關機功能關閉樂器電源時也會發
生這種情況。 

 務必將重要數據儲存到本樂器或 USB 隨身硬碟(第 60
頁)。請切記，儲存到本樂器的數據，可能由於某些故障、
操作失誤等丟失。因此請將重要數據儲存到 USB 隨身硬
碟(第 60 頁)。使用 USB 隨身硬碟之前，請確保參見第 61
頁。 

 
 
 
 
 
 
 
 
 
 
 
 

本產品的型號、製造號碼、電源要求等規格可能標在銘牌
上或銘牌附近，銘牌位於本機底部。請將該序列號填寫到
下方的橫線上，並妥善保存本說明書，以便在產品被盜時
作為永久購買憑證使用。 

型號名稱 
 

製造號碼 

(bottom_zh_01) 

信息 

■ 關於版權 
 除個人使用外，嚴禁複製作為商品的音樂作品數據，包括

但不限於 MIDI 數據和/或音頻數據。 
 對於本產品中的附帶及捆綁內容，Yamaha 擁有版權或經

許可可以使用其它公司的版權。根據版權法和其它相關法
律規定，用戶不得傳播通過儲存或錄製這些內容所得的媒
體，或與本產品中此類內容相同或類似的媒體。 
* 上述內容包括電腦程式、伴奏數據、MIDI 數據、WAVE

數據、音色錄音數據、樂譜、樂譜數據等。 
* 用戶可以傳播使用這些內容進行演出或音樂製作所錄

製的媒體，此類情況下無需 Yamaha 公司的許可。 

■ 關於本樂器的功能/數據包 
 本設備能夠使用各種類型/格式的音樂數據，將其預先優化

為便於本設備使用、正確的音樂數據格式。因此，在播放
這些音樂數據時，本設備可能無法精確地達到音樂製作人
或作曲家最初預想的程度。 

■ 關於本說明書 
 為便於您理解使用說明書的內容，本公司已經依據國家的

相關標準盡可能的將其中的英文表述部分翻譯成中文。但
是，由於(音樂上旋律、節奏、曲目等的)專業性、通用性
及特殊性，仍有部分內容僅以原文形式予以記載。如您有
任 何 問 題 ， 煩 請 隨 時 與 本 公 司 客 服 聯 繫 ( 專 線 ：
400-051-7700)。 

 方括號表示螢幕按鈕、接口和控制面板中的按鈕。 
 Windows 是 Microsoft® Corporation 在美國及其它國家的

註冊商標。 
 Apple、macOS、Mac、iPhone、iPad、iPod touch 和 Logic

是 Apple Inc.在美國和其它國家或地區的註冊商標。 
 Ableton 是 Ableton AG 的商標。 
 IOS 是 Cisco 在美國和其他國家或地區的商標或註冊商標

並具有使用許可證。 
 本使用說明書中所使用的公司名和產品名都是各自公司

的商標或註冊商標。 
 

Yamaha 會時刻更新產品的韌體，在功能和實用工具中的
改進恕不另行通知。為了全面利用本樂器的優勢，我們建
議您將您的樂器升級到最新版本。可以從以下網址下載最
新版本的韌體。 
https://download.yamaha.com/ 
 
進入 Support 網頁(或點擊 “Firmware/Software”)後，輸入
相應的型號名稱。 

 



MODX 使用說明書 5 

備忘錄 
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Sounds 

Design 

MODX 開發團隊的話 

感謝您購買 Yamaha MODX6/7/8 音樂合成器。在這款合成器的設計過程中，我們讓需要嶄新而驚豔的聲音表達成為
可能，也為更廣泛的演奏者帶來了旗艦合成器 MONTAGE 的使用體驗。 
 
 
 
 
 

 

聲音 

MODX 具備動態控制合成引擎，與安裝在 MONTAGE 中的聲音處理系統相同。能帶來高解析度的 AWM2
聲音和動態的 FM-X 聲音，並且能夠通過各種控制器無縫無瑕地進行控制。 
同時，MODX 具有能夠直接添加節奏模式的新功能，用戶能夠用動態節奏聲部來創作自己的音樂。通過
這些功能，在 “動態控制系統” 中創造節奏變換將更加便捷！ 

 
 
 
 
 
 
 

設計 

MODX 在設計上輕質便捷，同時又具備全功能的超級旋鈕、大尺寸彩色 LCD 和其他控制器，具有與
MONTAGE 相同的可操作性和外觀。通過 MODX，可以將 MONTAGE 的聲音運用在幾乎任何演奏中。 

 

我們由衷地希望 MODX 6/7/8 可以成為您音樂創作和音樂製作工作的得力助手。 
開始享受音樂吧！ 

此致！
Yamaha MODX 開發團隊
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感謝您購買 Yamaha 產品。 
本合成器為現場演奏和音樂製作使用而設計。 
為了充分利用本樂器高級而又方便的功能，我們建議您仔細閱讀本說明書。 
也建議您將本說明書放置於安全便捷的地方，以便將來隨時參閱。 
 
 

關於本使用說明書 

 使用說明書(本書) 

本樂器基本功能的總體介紹。使用本使用說明書了解對 MODX 基本操作的概述。如果您需要了解對指定功能的詳細信
息或說明，請使用以下所述的參考說明書。 
 

 PDF 文件 

■ 參考說明書 
詳細介紹內部結構和連接示例。如果您想要了解使用說明書中未涵蓋的詳細信息，請使用參考說明書。 

■ 合成器參數說明書 
通用的跨產品文件介紹所有合成器使用的參數、效果類型、效果參數和 MIDI 信息。請先閱讀使用說明書和參考說
明書，然後在需要時使用本參數說明書，以便總體了解更多與 Yamaha 合成器相關的參數和術語。 

■ Data List 
提供了多種重要列表，如演奏列表、波形列表、效果列表、琶音類型列表和 MIDI 變形表。 

 

如何使用 PDF 說明書 
參考說明書、合成器參數說明書和 Data List 以 PDF 文檔形式提供。上述 PDF 說明書可從 Yamaha Downloads 網
頁獲取。若要獲取說明書，使用下列 URL，在 “Model Name” (型號名稱)區域輸入 “MODX” 然後點擊 “Search” (搜
索)。 
Yamaha Downloads： 
https://download.yamaha.com/ 
 
訪問 Support 網站(並點擊 “Manual Library”)後，輸入相應的型號名稱。 
 
可在電腦上查看和閱讀這些 PDF 文件。使用 Adobe® Reader®查看 PDF 文件時，可搜索指定詞語、列印指定頁或
連結以便在說明書中打開所需部分。術語搜索和連結功能是瀏覽 PDF 文件時相當便捷的方法，推薦使用這 2 個功
能。可從以下 URL 下載最新版本的 Adobe Reader。 
http://www.adobe.com/products/reader/ 

 
 
 

附件 
 AC 電源變壓器 
 使用說明書(本書) 
 Cubase AI Download Information 
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主要功能 
 

■ 音樂風格廣泛、高品質、增強型聲音 
MODX 載有 5 GB (16 位線性格式)的預置先進波形記
憶(AWM2) ──與 MONTAGE6/7/8 相同容量。MODX
具有廣泛聲音，包括帶有大量波形數據的高度真實的
鋼琴聲音。MODX 配備內建 1.0 GB 用戶隨身硬碟，
用於儲存各種演奏組群組。即使電源關閉，也會按照
與預置演奏組相同的方法保留演奏組數據。MODX
還配備 FM-X 音源，提供強勁複雜的 FM 合成。由此
將標準化 FM 和新一代 FM 聲音同時放入音波板塊，
讓各種具有表現力、層次豐富的聲音為您所用，並將
FM-X 和 AWM2 音源結合在一起。 

■ 廣泛效果處理 
MODX 具 有 大 量 專 業 和 新 式 的 音 樂 效 果 ， 包 括
Spiralizer、Rotary Speaker 2、Uni Comp Down、
Uni Comp Up、Parallel Comp 和 Presence。本樂器
還提供各種信號處理選項，包括獨立變奏和殘響，並
提供整體主控效果，包括多頻段壓縮、五頻段主 EQ、
獨立插入效果以及插入效果之前的三頻段 EQ 和插
入效果之後的兩頻段 EQ。這些插入效果具有各種聲
音處理選項，包括專業 Vocoder 效果。 

■ 動態控制系統以實現新的音樂潛力 
動態控制系統是全新功能，用於實時靈活控制動態
(節奏、多維聲音變化)。這一驚人功能以前所未有的
全新方式明顯且動態改變本樂器的聲音──在層次和
節奏上更改節拍，提供色彩豐富的冷色調光線效果並
富有表現力地回應您的創作激情。 
動態控制系統有三個主要功能： 

1) 超級旋鈕： 
用於創建多維音波變化，並以色彩豐富、持續移
動的光線變化來增強。 

2) 動態音序器： 
用於持續可變的聲音變化。 

3) 封包跟隨器： 
將運動與音頻輸入和其他部分的速度和音量同
步。 

■ 節奏模式功能 
MODX 具有強大的節奏模式功能，通過該功能可以
使用節奏聲部動態地創建聲音。您可以在動態控制系
統中使用封包跟隨器直接分配節奏聲部並創建節奏
變化。 

 
 
 
 
 
 
 
 
 
 
 

■ 擴展、增強的琶音功能和動態音序 
MODX 具有超過 10,000 種琶音，覆蓋最新的音樂風
格。通過進一步增強本樂器的音樂表現力，可以將用
於製造動態聲音變化的動態音序功能和各種琶音類
型相結合。您可以將所有內容──琶音類型、動態音
序和聲部音量等其他參數──作為場景儲存在一起，
並將其分配到八個按鈕，從而在演奏時根據需要便捷
有效地調出這些場景。 

■ 方便的現場演奏功能 
MODX 具有現場設置功能，用以在台上演奏時輕鬆
調出演奏組。一旦以所需順序儲存演奏組，即可完全
專注於演奏，而無需在選擇時措手不及。MODX 還
具有 SSS (無縫聲音切換)功能，用於在演奏組之間
順暢切換，不會切掉任何音符。 

 
*1：SSS 功能至多對四個聲部的演奏有效。 

■ 增強型用戶介面 
MODX 與其前款不同，設計理念沒有局限於任何 “模
式”。因此，本樂器的結構和流程更易理解，並且使
用便捷的觸摸面板也是一種愉快的體驗。您可以根據
需要創意並有效使用觸摸面板進行直觀操作，使用開
關進行更多安全控制。這些開關以三種方式點亮，可
讓您即時了解開關的當前狀態。 

■ 緊湊的設計，真實又充滿表現力的鍵盤 
MODX 外觀緊湊輕質，便於攜帶。儘管攜帶方便，
MODX 依然具備真實自然的鍵盤，使用戶能夠愉悅
地彈奏：MODX 6 具有 61 個琴鍵，MODX 7 具有 76
個琴鍵和半配重鍵盤，MODX 8 具有 88 個琴鍵和高
品質 GHS 鍵盤。 

■ 全面系統連接 
MODX 配備內建 4 通道輸入/10 通道輸出 USB 音頻
接口，用於在 Mac 或 Windows PC 上錄製 MODX 的
高品質聲音(44.1 kHz 採樣頻率)──無需另外的設
備！這些連接也兼容 iOS 設備。 
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控制器和功能 
頂部面板 

 
 

 鍵盤 
MODX 6 配有 61 鍵的鍵盤，MODX 7 配有 76 鍵的鍵盤，
MODX 8 配有 88 鍵的鍵盤。本樂器通過初始力度感知彈
奏琴鍵力度的強弱，並根據所選演奏組使用彈奏力度以
各種方式改變聲音。 

 彎音輪 
用於控制彎音效果。也可以將其它功能分配到此控制器。 

 調製輪 
用於控制調製效果。也可以將其它功能分配到此控制器。 

 [MASTER VOLUME]旋鈕(第 19 頁) 
順時針或逆時針轉動旋鈕控制 OUTPUT [L/MONO]/[R]
插孔和[PHONES]插孔的輸出電平。 

 [USB VOLUME (MONITOR)]旋鈕 
控制[USB TO HOST]插孔至 OUTPUT [L/MONO]和[R]
插孔及[PHONES]插孔的音頻輸入音量。 

 A/D INPUT [GAIN]旋鈕(第 50 頁) 
使用此旋鈕可以調節 A/D INPUT [L/MONO]/[R]插孔中音
頻信號的輸入增益。順時針轉動旋鈕將增加增益電平。 

註 
根據連接到 A/D INPUT [L/MONO]/[R]插孔的外接設備的
輸入電平，可能需要按照以下順序更改設置：[UTILITY] 
→ [Settings] → [Audio I/O] → [A/D Input]。當相連設
備(如麥克風、吉他或貝司)的輸出電平較低時，將此參數
設置為 “Mic”。當相連設備(如合成器鍵盤或 CD 播放機)
的輸出電平較高時，將此參數設置為 “Line”。 

 A/D INPUT [ON/OFF]按鈕(第 50 頁) 
切換本樂器是否接收通過 A/D INPUT [L/MONO]/[R]插孔
輸入的音頻信號。當啟用 A/D 輸入時，按鈕點亮；禁用
時，按鈕熄滅。 

 [ASSIGN 1]和 [ASSIGN 2]按鈕 
(可分配開關 1 和 2) 

鍵盤演奏期間，可以通過這些按鈕調出所選演奏組的指
定元素/操作器。此外，可以將其他功能分配到這些開關。
當打開效果之一時，對應按鈕點亮，反之亦然。 
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 [MOTION SEQ HOLD] (動態音序器保持)按
鈕 

動態音序器播放時按下此按鈕後，將使聲音保持或定格
在按下按鈕時音序的位置。保持效果打開時，按鈕點亮。 

 [MOTION SEQ TRIGGER](動態音序器觸發)
按鈕 

當動態音序器的觸發接收參數設置為 ON 時，按下該按
鈕動態音序器開始播放。按下時按鈕完全點亮。 

 [ARP ON/OFF] (琶音開/關)按鈕 
按下此按鈕可以啟用或禁用琶音的播放。如果所選聲部
的琶音開關設置為關，按下該按鈕也無效。當啟用琶音
時，按鈕點亮；禁用時，按鈕熄滅。 

 [MS ON/OFF] (動態音序器開/關)按鈕 
決定是否啟用動態音序器。如果所選聲部或序列的動態
音序器開關設置為關，按下該按鈕也無效。當啟用動態
音序器時，按鈕點亮。 

 OCTAVE [-]和[+]按鈕 
使用這些按鈕可改變鍵盤的八度範圍。這些按鈕也可用
作移調[-]和[+]按鈕。若要以半音為單位提高或降低音符
的音高，按住[SHIFT]按鈕並按下對應的[-]/[+]按鈕。若要
恢復標準八度設置，同時按下兩個按鈕。根據八度設置
按鈕以不同的方式點亮或閃爍。 
有關詳細說明，請參見參考說明書 PDF 文件。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

雖然插圖顯示 MODX 8，信息適用於所有型號。
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 旋鈕功能 [TONE]/[EG/FX]/[EQ]/[ARP/MS]按
鈕 

使用該按鈕選擇分配至旋鈕的功能。當前所使用參數旁
邊的指示燈將點亮。 
當樂器處於演奏組控制狀態時(第 30 頁)，功能通常應用
至所有聲部；當處於聲部控制狀態時(第 30 頁)，功能應
用至選定聲部。選定功能的指示燈將點亮。 

 [ASSIGN]按鈕 
切換旋鈕功能為分配 1–4 或分配 5–8。當樂器處於演奏
組控制狀態時(第 30 頁)，功能通常應用至所有聲部；當
處於聲部控制狀態時(第 30 頁)，功能應用至選定聲部。
當選中分配 1–4 時按鈕點亮；當選中分配 5–8 時按鈕閃
爍。 

 旋鈕 1–4 (5–8) 
面板上這四個多用途旋鈕可以調節各個重要參數，如當
前聲部、琶音速度和動態音序器。 
按下左上角的旋鈕功能[TONE]/[EG/FX]/[EQ]/[ARP/MS]
按鈕，或左側的[ASSIGN]按鈕更改分配到旋鈕的功能。
當[ASSIGN]按鈕點亮或閃爍時，作為可分配旋鈕使用。 

 滑桿功能[PART]/[ELEMENT/OPERATOR]按
鈕 

設置面板上的四個控制滑桿，用於控制聲部或控制元
素。每次按下該按鈕，滑桿功能在 PART 和 ELEMENT/ 
OPERATOR 之間交替。選定功能的指示燈點亮。 

 滑桿選擇[1–4] [5–8]按鈕 
選擇面板上的四個控制滑桿用作 1–4 或 5–8。每次按下
該按鈕，設置在 1–4 或 5–8 之間交替。當設置為 1–4 或
5–8 時，選定設置的指示燈點亮。 
當按住[SHIFT]按鈕的同時按下滑桿選擇按鈕，可以設置
控制滑桿功能為 9–12 或 13–16。當設置為 9-12 或 13-16
時，選定設置的指示燈閃爍。 

 控制滑桿 1–4 (5–8/9–12/13–16) 
滑桿根據各個按鈕的情況以不同方法調節 16 個聲部
(1–4/5–8/9–12/13–16)的各個電平、標準聲部(AWM2)的
8 個元素、一個標準聲部(FM-X)中的 8 個 FM 操作器和
鼓聲部的 8 個鍵，從而控制聲音的音量平衡。 

註 
 如果所有控制滑桿均設置為最小音量，即使彈奏鍵盤

或樂曲，也可能無法聽到來自本樂器的聲音。如果發
生以上情況，將所有滑桿推到適當音量。 

 [MASTER VOLUME]滑桿控制本樂器的整體音頻輸
出音量。另一方面，控制滑桿將聲部各元素/鍵/操作
器的電平和演奏組各聲部的音量作為參數進行控
制。因此，通過控制滑桿設置的值可作為演奏組數據
進行儲存。 

 場景選擇[1–4] [5–8]按鈕 
選擇面板上的四個 SCENE 按鈕用作場景 1–4 或場景
5–8。每次按下該按鈕，設置在 1–4 或 5–8 之間交替。
選定功能的指示燈點亮。 

 SCENE [1/5] [2/6] [3/7] [4/8]按鈕 
可以將重要聲部相關參數的不同 “快照” (如音軌靜音狀
態和基本混音設置)作為聲部場景分配到每個 SCENE 按
鈕。通過按下場景選擇按鈕，可以將按鈕配置為場景 1–4
或場景 5–8。 
 
當編輯場景相關參數且在按住[SHIFT]按鈕的同時按下
任一 SCENE [1/5]–[4/8]按鈕時，編輯內容會儲存到當前
所選的[SCENE]按鈕。按下所選按鈕可恢復儲存的信
息。當前所選按鈕完全點亮，儲存信息的按鈕微弱點亮，
沒有儲存信息的按鈕熄滅。 
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 KNOB POSITION [1]和[2]按鈕 
儲存分配 1–8 的參數值。可在兩個按鈕之間快速切換。
在按住[SHIFT]按鈕的同時按下 KNOB POSITION [1]按
鈕，可以儲存數值 1；在按下[SHIFT]按鈕的同時按下
KNOB POSITION [2]按鈕，可以儲存數值 2。同時按下
KNOB POSITION [1]和[2]可切換超級旋鈕動態音序器
ON 或 OFF。 

 超級旋鈕 
同時控制分配到旋鈕的參數(分配 1–8)。 

註 
還可以用踏板控制器(FC7)控制超級旋鈕。詳情，請參見
第 33 頁。 

 SEQ TRANSPORT 按鈕 
這些按鈕用於控制樂曲音序數據的錄音和播放。 

[ ] (復位)按鈕 
立刻回到當前樂曲的開始處(例如，第一小節的第一
拍)。 

[ ] (後退)按鈕 
每次快速按一下可後退一個小節。 

[ ] (前進)按鈕 
每次快速按一下可前進一個小節。 

[ ] (錄音)按鈕 
按下此按鈕可以調出錄音設置畫面。(按鈕閃爍。) 
按下[ ] (播放)按鈕開始錄製。([ ] (錄音)按鈕點亮。) 

[ ] (停止)按鈕 
按下可停止錄製或播放。即使琶音設置為釋音後持續
播放(琶音保持開關為 ON)，想要停止琶音播放時，
也可使用此按鈕。也可以使用該按鈕停止接收觸發信
號的動態音序器。 

[ ] (播放)按鈕 
按下可開始播放或錄製樂曲。錄製或播放期間，按鈕
以當前速度閃爍。 
 
 
 

 [RHYTHM PATTERN]按鈕 
使用此按鈕調出節奏模式畫面。選擇想要使用的節奏模
式，然後按下[PERFORMANCE (HOME)]按鈕或[EXIT]
按鈕設置選擇。 
再次按下該按鈕取消選擇並關閉節奏模式畫面。 

 [CONTROL ASSIGN]按鈕 
當在畫面上選擇可分配到控制器的參數時，按下此按鈕
並操作要用於分配的控制器。顯示控制器設置畫面。 

 觸摸面板 LCD 
LCD 用來顯示當前所選操作的數值和參數。可以通過觸
摸畫面進行操作。 
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 數據輪 
用於編輯當前選擇的參數。若要增加值，向右(順時針)
轉動數據輪；若要減小值，向左(逆時針)轉動數據輪。如
果選擇了數值範圍較寬的參數，可以快速轉動數據輪以
大幅度改變數值。 

 [DEC/NO]按鈕 
用於減小當前所選參數的值(DEC：減量)。此按鈕也可用
於取消作業或儲存操作。 
在按住[SHIFT]按鈕的同時按下[DEC/NO]按鈕將以 10 級
快速減小參數值。 

 [INC/YES]按鈕 
用於增大當前所選參數的值(INC：增量)。此按鈕也可用
於執行作業或儲存操作。 
在按住[SHIFT]按鈕的同時按下[INC/YES]按鈕以 10 級快
速增加參數值。 

 游標按鈕 
游標按鈕使 “游標” 在畫面四周移動，高亮顯示並選擇各
種參數。 

 [EXIT]按鈕 
MODX 的選單和畫面採用分級結構排列。按下此按鈕可
從當前畫面退出並返回到分級結構的前一級別。 

 [ENTER]按鈕 
使用此按鈕可以調出所選選單的畫面，執行作業或儲存
操作。 
在按住[SHIFT]按鈕的同時按下[ENTER]按鈕可以調出速
度設置畫面。 

 

 [PERFORMANCE (HOME)]按鈕 
使用此按鈕可以返回演奏組播放畫面。當顯示演奏組播
放畫面時，此按鈕完全點亮。當顯示工具畫面時，此按
鈕微弱點亮。 
當顯示演奏組播放畫面且游標在演奏組名稱上時，按下
該按鈕顯示或隱藏詳細信息，通過觸摸螢幕上的[View]
按鈕也可看到相同的信息。 
在 按 住 [SHIFT] 按 鈕 的 同 時 按 下 [PERFORMANCE 
(HOME)]按鈕可以調出概覽畫面。 

 [UTILITY]按鈕 
使用此按鈕可以調出工具畫面進行整體系統設置。當顯
示工具畫面時，此按鈕完全點亮；當顯示其他畫面時，
此按鈕微弱點亮。 
在按住[SHIFT]按鈕的同時按下[UTILITY]按鈕可以調出
快速設置畫面。 
當按下[PART SELECT MUTE/SOLO]按鈕的同時按下該
按鈕，打開觸摸面板校正畫面。 

 [EDIT]按鈕 
使用此按鈕可以調出用於編輯演奏組(第 22 頁)和現場設
置(第 35 頁)的畫面。此外，在編輯演奏組參數時按下此
按鈕，將在剛編輯的聲音和原始、未編輯狀態之間切換，
以便試聽編輯效果(比較功能)。當顯示編輯畫面時，此按
鈕點亮；當啟用比較功能時，此按鈕閃爍。 

 [STORE]按鈕 
使用此按鈕可以調出儲存畫面。當顯示儲存畫面時，此
按鈕完全點亮；當顯示其他畫面時，此按鈕微弱點亮。 

 [SHIFT]按鈕 
與其它按鈕一起按下該按鈕可執行各種命令。詳情請參
見 “SHIFT 功能列表” (第 62 頁)。 
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 [LIVE SET]按鈕 
使用此按鈕可以將所有喜愛且常用的演奏組儲存在一個
易於訪問的位置並調用。 
在按住[SHIFT]按鈕的同時按下[LIVE SET]按鈕可以調出
現場設置畫面，用於將當前所選演奏組儲存到現場設
置。這是一種更加有效的方法，可以在現場演奏組的情
況下在所需的演奏組之間快速切換。 
當顯示現場設置畫面時，此按鈕完全點亮。如果不顯示
現場設置畫面，當啟用現場設置功能時，此按鈕微弱點
亮；當不啟用現場設置功能時，此按鈕熄滅。 

 [CATEGORY]按鈕 
使用此按鈕可以訪問分類查找功能(第 24 頁)。 
當顯示演奏組播放畫面時使用此按鈕可以調出用於選擇
整個演奏組的演奏組分類查找畫面。當游標位於演奏組
播放畫面中的聲部名稱上時，在按住[SHIFT]按鈕的同時
按下[CATEGORY]按鈕可以調出聲部分類查找畫面，允
許選擇當前所選聲部的聲音類型。當顯示分類查找畫面
時，此按鈕完全點亮。如果不顯示分類查找畫面，當啟
用分類查找功能時，此按鈕微弱點亮，當不啟用分類查
找功能時，此按鈕熄滅。 

 [PART SELECT MUTE/SOLO]按鈕 
使 用 該 按 鈕 選 擇 一 個 聲 部 或 將 Mute 或 Solo 設 為
ON/OFF。在演奏組播放畫面按下該按鈕打開聲部選擇窗
口。 
 

按鈕 操作 
1-8 顯示聲部 1-8 
9-16 顯示聲部 9-16 
Select 切換至聲部選擇畫面 
Mute 切換至靜音設置畫面 
Solo 切換至獨奏設置畫面 

 
靜音聲部顯示字母 “M”，獨奏聲部顯示字母 “S”。 
 
若要關閉聲部選擇窗口，再次按下該按鈕或觸摸螢幕上
的 “x” 標記。 
 
當螢幕上顯示聲部選擇窗口時，按鈕完全點亮；當聲部
選擇窗口未顯示時，按鈕微弱點亮。在工具畫面、現場
設置畫面或其它任何無需聲部選擇的畫面中按鈕熄滅。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 [AUDITION]按鈕 
使用此按鈕(在演奏組播放、現場設置或分類查找畫面中)
可以播放或停止樣本樂句演示所選演奏組聲音。此演奏
組的樣本樂句被稱為 “試聽樂句”。當其為 ON 時，此按
鈕完全點亮；在分類查找等畫面啟用試聽功能時，此按
鈕微弱點亮。 
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後面板 

■ 後面板左側 

 

■ 後面板右側 

 

 

雖然插圖顯示 MODX 8，信息適用於所有型號。

電腦

USB 隨身硬碟

外接 MIDI 鍵盤 

有源音箱
播放設備

耳機

麥克風
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■ 後面板左側 

 [USB TO HOST]端口 
用於通過 USB 線纜將本樂器連接到電腦，並在設備之間
傳輸 MIDI 數據和音頻數據。與 MIDI 不同，USB 通過一
根線纜即可操作多個端口(第 56 頁)。有關 MODX 如何操
作端口的信息，請參見第 56 頁。 

註 
本樂器的音頻數據發送能力最多 10 通道(5 個立體聲通
道)；音頻數據接收能力最多 4 通道(2 個立體聲通道)。 

 [USB TO DEVICE]端口 
用於將本樂器連接到 USB 隨身硬碟。可將在本樂器上創
建的數據儲存到 USB 隨身硬碟，並將數據從 USB 隨身
硬碟加載到本樂器。可執行儲存/加載操作：[UTILITY] → 
[Contents] → [Store/Save]或[Load]。 

註 
 本樂器只能識別 USB 隨身硬碟。不可使用其他 USB

設備(如硬碟驅動器、光驅和 USB 集線器)。 
 本樂器支援 USB 1.1 至 3.0 標準。但是，傳送速率因

數據類型和本樂器的狀態而異。 
 

■ 後面板右側 

 MIDI [IN]、[OUT]端口 
MIDI [IN]用於從外接音序器等其他 MIDI 設備接收控制或
演奏組數據，可讓您從連接的單獨 MIDI 設備控制本樂器。 
MIDI [OUT]用於將本樂器的所有控制、演奏組和播放數
據發送到外接音序器等其他 MIDI設備。同時，MIDI [OUT]
能夠用作 MIDI Thru。若要更改設置，按下[UTILITY]按
鈕打開工具畫面。 

 FOOT SWITCH [ASSIGNABLE]/[SUSTAIN]
插孔 

用於將另售的 FC3/FC4/FC5 腳踏開關連接到[SUSTAIN]
插孔並將 FC4/FC5 腳踏開關連接到[ASSIGNABLE]插
孔。連接到[SUSTAIN]插孔時，腳踏開關控制延音。連接
到[ASSIGNABLE]插孔時，腳踏開關控制各種可分配功
能之一。 

註 
 本使用說明書中的術語 “FC3” 是 FC3 和其他兼容

FC3 的腳踏開關(如 FC3A)的統稱。 
 本使用說明書中的術語 “FC4” 是 FC4 和其他兼容

FC4 的腳踏開關(如 FC4A)的統稱。 
 
 
 
 
 
 
 
 
 
 
 
 
 

 FOOT CONTROLLER [1]/[2]插孔 
用於連接另售的踏板控制器(FC7 等)。此插孔可持續控制
聲部編輯中各種不同可分配功能中的一種，如音量、音
調、音高或其它聲音特性(請參見參考說明書的 PDF 文
件)。 

 OUTPUT [L/MONO]和[R]插孔 
通過這些標準耳機插孔輸出線路等級音頻信號。對於單
聲道輸出，只使用[L/MONO]插孔。 

 [PHONES] (耳機)插孔 
此標準立體聲耳機插孔用於連接一副立體聲耳機。此插
孔與 OUTPUT [L/MONO]和[R]插孔輸出相同的音頻信
號。 

 A/D INPUT [L/MONO]/[R]插孔 
可通過這些耳機插孔(1/4"單聲道耳機插頭)輸入外接音
頻信號。麥克風、CD 播放機或合成器等各種設備可連接
到這些插孔，且設備的音頻輸入信號可用作音頻聲部。 
此外，通過將麥克風連接到[L/MONO]插孔並將聲音輸入
麥克風，可以使用專用 Vocoder 功能。 
還可以使用封包跟隨器和 ABS (音頻節拍同步)功能。封
包跟隨器功能用於檢測輸入信號波形的音量封包並動態
改變聲音。 

註 
 可直接連接具備主動式拾音器的吉他或貝司。但是，

使用被動式拾音器時，需通過效果器連接本樂器。 
 從所有聲部輸出，不僅僅從 A/D INPUT [L/MONO]/[R]

插孔控制 Vocoder/封包跟隨器。 
 
ABS (音頻節拍同步)功能用於檢測從這些插孔輸入的音
頻信號的節拍，並與動態音序器或琶音同步節拍。 
使用 1/4"單聲道耳機插頭。對於立體聲信號(如來自音頻
設備的信號)，使用[L/MONO]/[R]插孔。對於單音信號(如
來自麥克風或吉他的信號)，僅使用[L/MONO]插孔。 
有關封包跟隨器和 ABS 功能的詳細說明，請參見參考說
明書的 PDF 文件。 

 [ ] (待機/開機)開關 
按下可設置為開機或待機。 

 [DC IN] 
插上本樂器附帶的 AC 電源變壓器。 
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電源 
按照以下順序連接附帶的 AC 電源變壓器。連接 AC 電源
變壓器前，請確保將本樂器上的[ ] (待機/開機)開關設置
到待機( )位置。 

1 將 AC電源變壓器的 DC輸出線纏繞在線纜夾

上(如下圖所示)，然後將適配器的插頭連接至

後面板的 DC IN (直流輸入)插孔。 

 

註 
使用線纜夾可防止操作中意外拔出線纜。將線纜繞在
線纜夾上時，請確保避免將線纜繃得過緊或用力拉
拽，以防造成線纜磨損或線夾損壞。 

2 將 AC 電源變壓器的另一端連接到 AC 電源 
插座。 

 

註 
當斷開 AC 電源變壓器時，逆向操作上述步驟。 

警告 
 只能使用規定的 AC 電源變壓器(第 71 頁)。使用不適

當的適配器可能會導致本樂器損壞或過熱。 
 當使用帶有可移動插頭的

AC 電源變壓器時，請確

保插頭附屬於 AC 電源變

壓器。單獨使用插頭可能

造成觸電或火災。 
 安裝插頭時請牢記不要碰

觸金屬部分。為避免觸

電、短路或設備損壞，注

意 AC 電源變壓器和插頭

之間不要有灰塵。 
 

注意 
 安裝本產品時，請確認要使用的交流電源插座伸手可

及。如果發生問題或者故障，請立即斷開電源開關並

從電源插座中拔下插頭。 
 即使[ ] (待機/開機)開關設置到待機位置，本樂器仍

保持充電並消耗少量電能。因此，如果長時間不使用

本樂器，務必從壁式插座中拔出電源線。 
 

連接喇叭或耳機 
由於本樂器沒有內建喇叭，用戶必須使用外接設備對本
樂器的聲音進行監聽。如下圖所示連接一副耳機、有源
音箱或其它播放設備。連接時，務必保證電纜的額定值
適當。 

 

 

打開系統電源 
在開啟電源之前，務必將本樂器和外接設備(如有源音箱)
的音量調至最低值。將本樂器連接到有源音箱時，按照
以下順序開啟各個設備的電源開關。 

打開電源時： 
首先是本樂器(顯示屏打開且按鈕點亮)，然後是連接的有
源音箱。 

關閉電源時： 
首先是連接的有源音箱，然後是本樂器(顯示屏關閉且按
鈕熄滅)。 
 
請切記，[ ] (待機/開機)開關位於本樂器後面板 DC IN 
(直流輸入)插槽的左側(從鍵盤側看)。 

 
 
 

線纜夾 

請當心不要彎曲
接頭。 

DC IN (直流輸入)插孔 
(第 16 頁) 

AC 電源插座

AC 
電源適配器 

插頭

如圖所示滑入插頭。
您所在地區的插頭形狀

可能有所不同 

有源音箱(左) 有源音箱(右)

耳機

(待機/開機)開關 
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自動關機功能 
為避免不必要的電力消耗，本樂器配有自動關機功能，
設備處於不操作狀態一段時間後，能夠自動關閉電源。 

自動關機設置 
可設置電源自動關機前經過的時間長度。 
 

說明： [UTILITY] → [Settings] → 
[System] → [Auto Power Off] 

設置值(分鐘)： off (禁用自動關機)、5、10、15、
30、60、120 

默認設置(分鐘)： off 
 

禁用自動關機功能(簡單方法) 
按住鍵盤上的最低音琴鍵的同時，打開電源。這時會出
現提示信息 “Auto power off disabled”，自動關機功能即
被禁用。即使關閉電源，該設置也將保留。 

 

須知 
 即使本樂器的電源已經關閉，也會有少量的電流通向

本樂器。若要完全斷電，請務必將電源線插頭從插座

中拔出。 
 根據本樂器狀態的不同，即使指定的計時時間已經消

耗過去，電源也可能無法自動關閉。不使用樂器時請

手動關閉電源。 
 連接著諸如擴大機、喇叭或電腦等外接設備時，如果

一定時間之內不操作本樂器，確保按照使用說明書中

的說明以正確順序關閉本樂器及所連接設備的電

源，以保護設備不會損壞。如果設備連接時不需要自

動關閉電源功能，請禁用自動關機功能。 
 如果電源關閉前沒有備份，設置將其恢復為默認值。 
 當自動關機設置為 “off” 時，即使將儲存在其它設備

上的備份數據載入本樂器，值也將保留下來。當自動

關機設置為 “off” 以外時，加載的數據將覆蓋該值。 

註 
 設置的時間為近似值。 
 若要在執行自動關機後開啟電源，請按下[ ] (待機/

開機)開關將開關設置到待機( )位置並再次按下。 
 恢復出廠設置時，設置時間將變為默認值(off)。 
 
 
 
 
 
 
 
 

調節主音量輸出 
使用[MASTER VOLUME]旋鈕調節本樂器的整體音量。 

 

注意 
請勿長時間以高音量使用耳機。否則可能會造成聽力損

傷。 
 

恢復初始出廠設置(初始化所有數據) 

須知 
當執行初始化所有數據操作時，所有演奏組、樂曲以及

在工具畫面上創建的任何系統設置都將被刪除。請勿覆

蓋重要數據。執行本操作之前，請務必將所有重要數據

儲存到 USB 隨身硬碟中(第 60 頁)。 

1 按下 [UTILITY]按鈕或觸摸螢幕右上方的

UTILITY 圖標調出工具畫面。 

2 觸摸螢幕左側的[Settings]選項分頁，然後觸

摸[System]選項分頁。 
顯示整個系統設置畫面。 

3 觸摸螢幕右下方的[Initialize All Data]。 
畫面將提示進行確認。若要取消該操作，請觸摸螢幕
上的[Cancel No]或按下面板上的[DEC/NO]按鈕。 

4 觸摸螢幕中的[Yes]，或按下[INC/YES]按鈕執

行初始化所有數據的操作。 
 

最小 最大
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基本操作和顯示畫面 
MODX 備有方便的觸摸屏。直接觸摸螢幕即可操作各種設置和選擇所需參數。此外，還可使用數據輪和其他按鈕進行
畫面操作。 
 

顯示屏(觸摸面板)配置 

本節說明顯示屏所有類型的導航欄和畫面選擇選項分頁
的通用操作。對於插圖，以 MODX 打開時顯示 MODX
的現場設置畫面和演奏組播放畫面(主畫面)為示例。 

註 
可以更改開機畫面(打開電源時首個顯示的畫面)。有關設
置的詳細信息，請參見第 51 頁。 

現場設置畫面 

 

 HOME 圖標 
移至演奏組播放畫面。 

 EXIT 圖標 
功能與面板上的[EXIT]按鈕相同。按下此圖標可以從
當前顯示級別返回到前一顯示級別。 

 INFORMATION 區域 
顯示幫助信息，包括當前選擇的畫面名稱。 

 EFFECT 圖標 
觸摸此圖標可以調出效果開關畫面。當任一效果模組
(插入、系統或主控)關閉時，此圖標熄滅。 

 QUICK SETUP 圖標 
顯示本地控制 ON/OFF 和 MIDI IN/OUT 的設置。 
當本地控制設置為 ON 時，鍵盤形狀圖示點亮；當本
地控制設置為 OFF 時，鍵盤形狀圖標熄滅。 
當 MIDI IN/OUT 設置為 MIDI 時，將顯示 MIDI 接口
形狀圖標。當 MIDI IN/OUT 設置為 USB 時，將顯示
USB 接口形狀圖標。 
觸摸所需圖標可以調出對應的快速設置畫面。 

 
 
 
 
 
 
 

 TEMPO SETTING 圖標 
顯示當前所選演奏組的速度。觸摸此圖標可以調出速
度設置畫面。 

 UTILITY 圖標 
觸摸此圖標可以調出工具畫面中最後打開的畫面。 

演奏組播放畫面 

 

 LIVE SET 圖標 
觸摸此圖標可以調出現場設置畫面。 

 畫面選擇選項分頁 
觸摸所需選項分頁可以調出對應的畫面。 

 View 按鈕 
決定每個聲部的詳細信息是(On)否(Off)顯示。顯示的
信息根據游標位置或滑桿功能設置有所不同。 

移動游標 

使用這四個按鈕瀏覽畫面，在螢幕中的各種可選項目和
參數間移動游標。選定以後，相關項目將高亮顯示(游標
形狀變為黑色塊，字符變為反色)。可以使用數據輪、
[INC/YES]和[DEC/NO]按鈕更改游標所在處的項目(參數)
值。 

 

 

導航欄
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改變(編輯)參數值 

向右(順時針)旋轉數據輪增加數值；向左(逆時針)旋轉減
小數值。 
按下[INC/YES]按鈕可將參數值增大一檔；按下[DEC/NO]
按鈕可減小一檔。 
對於大數值範圍參數，可以通過按住[SHIFT]按鈕的同時
按下[INC/YES]按鈕的方法以 10 為單位增大數值。若要
以 10 為單位減小數值，可在按住[SHIFT]按鈕的同時按
下[DEC/NO]按鈕。 

 

命名(輸入字符) 

可以自由命名已創建的數據，如儲存到 USB 儲存設備的
演奏組、樂曲和文件。觸摸命名參數或將游標移動到命
名參數並按下[ENTER]按鈕調出輸入字符畫面。 

 

 刪除所有字符。 

 恢復默認名稱。 

 在大寫和小寫字母字符之間切換。 

 調出輸入數字、標點符號和各種字符的畫面。 

 在游標位置插入空格(空白)。(也可以使用[INC/YES]
按鈕進行相同操作。) 

 移動游標位置。 

 刪除上一個字符(退格)。(也可以使用[DEC/NO]按鈕
進行相同操作。) 

 完成文本輸入並關閉畫面。 

 
 
 
 
 
 

使用鍵盤上的鍵和數字鍵盤畫面輸入 

對於某些參數，也可以將 LCD 用作數字鍵盤或使用鍵盤
上的鍵直接輸入數值。在需要輸入數字類值的參數時，
啟動琴鍵輸入。輸入數值時，啟動數字鍵盤輸入。觸摸
所需參數或移動游標到參數並按下[ENTER]按鈕調出有
兩個選單的畫面(如下所示)。 

 

 啟用鍵盤輸入。 
可以在鍵盤上彈奏音符，並輸入音符或力度。 

 啟用數字鍵盤輸入。 
可以使用數字鍵盤直接輸入數字。也可使用數據輪、
[INC/YES]按鈕和[DEC/NO]按鈕增大或減小輸入數
字。 

數字鍵盤畫面 

 
 清除所有數字。 

 將值恢復到最後的設置。 

 刪除最後一位數字。 

 完成輸入操作並關閉數字鍵盤畫面。 

 

減小數值 增大數值

減小數值 增大數值
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選擇演奏組 
 
MODX 有 16 個聲部，基本樂器聲音分配到各聲部。這些
聲音的一組稱為 “演奏組”。通過選擇合適的演奏組，根
據需要更改聲音。 

 

有如下三個聲部類型。 

標準聲部(AWM2) 
標準聲部(AWM2)主要是可以在鍵盤區域內演奏的有音
高的樂器型聲音(鋼琴、風琴、吉他、合成器等)。 

標準聲部(FM-X) 
標準聲部(FM-X)是強勁的 FM 合成系統聲音。此種聲音
通常從鍵盤彈奏，每個鍵位採用標準音高發聲。 

鼓聲部 
鼓聲部主要是分配到單個音符的打擊樂/鼓聲。 
 
 
演奏組也可分為如下兩組。 

單聲部演奏組 
單聲部演奏組僅包含一個聲部。如果想要演奏單一樂
器，選擇此項。 

多聲部演奏組 
多聲部演奏組包含多個聲部。如果想要通過疊加和分割
功能演奏多個樂器的聲音，選擇此項。 
 
 
 
 
 
 
 
 
 
 

本樂器具有用於儲存演奏組的群組。基本有四種不同類
型的群組：預置、用戶、資料群組和 GM。各群組所包含
的演奏組和功能如下所述。 

預置群組 
預置群組包含一整套專用編程的演奏組。自行編輯的演
奏組無法保存在預置群組中。 

用戶群組 
使用者群組包含已編輯和儲存的演奏組。用戶群組最初
為空。 

須知 
如果用戶群組中的演奏組(用戶演奏組)被覆蓋或更換，該
用戶演奏組將丟失。當儲存已編輯的演奏組時，注意不
要覆蓋任何重要的用戶演奏組。 

資料群組 
資料群組包含已作為資料群組添加的演奏組。資料群組
最初為空。(可通過導入資料群組文件添加資料群組。) 

GM 群組 
GM 群組包含根據 GM 標準分配的聲部。 
 

GM 
 
GM (通用 MIDI)是合成器及音源的音色組織和 MIDI 功
能的世界標準。主要用來確保任何用特定 GM 設備創建
的樂曲數據在其他 GM 設備上聆聽都一樣，無關製造商
或型號。本合成器中的 GM 群組用於實現 GM 樂曲數
據的正確播放。請切記，聲音效果可能和原始音源演奏
的不完全一致。 

 
這些群組各自包含根據演奏組類型劃分的演奏組。 

註 
 有關演奏組的詳細信息，請參見參考說明書的 PDF

文件的 “基本結構”。 
 有關演奏組列表，請參見單獨的 PDF 形式的 Data 

List。 
 

多個演奏組 

演奏組

聲部 1 (鋼琴) 

聲部 2 (吉他) 

聲部 3 (貝司) 

聲部 4 (鼓)

聲部 16
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首次打開本樂器時，預置群組的現場設置將顯示在頂部
顯示屏中。現場設置是可以自由排布演奏組的列表。一
頁最多可以排布 16 個演奏組。可以彈奏從預置現場設置
中選擇的各種演奏組。 
 
 

從現場設置中選擇演奏組 

1 按下[LIVE SET]按鈕。 
將調出現場設置畫面。 

 

 頁面(通過按下螢幕中的[ ][ ]切換) 

註 
也 可 以 使 用 [SHIFT] 和 [INC/DEC] 或 [SHIFT] 和
[DEC/NO]切換頁面。 

 
 預置群組/用戶群組(通過按下螢幕中的[ ][ ]切
換) 

 演奏組列表 

 啟用演奏組名稱 

 插槽名稱 

 標記(見下表) 
 

標記 定義 
AWM2 僅由 AWM2 聲部組成的演奏組 
FM-X 僅由 FM-X 聲部組成的演奏組 
AWM2+FM-X 由 AWM2 和 FM-X 聲部組成的演

奏組。 
MC 具有動態控制的演奏組 
SSS 具有無縫聲音切換的演奏組 

註 
“無縫聲音切換” 功能可讓您在演奏組之間順暢切
換，不會切掉任何音符。SSS 功能適用於本樂器中
的所有預置群組演奏組。但是，SSS 僅適用於包含
聲部 1–4 的演奏組，而不適用於使用聲部 5–16 的演
奏組。 

 
 
 
 
 
 
 

2  在螢幕上觸摸所需演奏組。 

註 
如要重新排列現場設置中已註冊演奏組的順序，請參
見第 35 頁。 

3 彈奏鍵盤。 
 
 

切換演奏組 

1 按下[PERFORMANCE (HOME)]按鈕。 
顯示演奏組播放畫面，並且顯示當前演奏組名稱。 

 

2 將游標移至演奏組名稱並使用數據輪、

[INC/YES]按鈕或[DEC/NO]按鈕選擇所需演

奏組。 

註 
 若要以 10 級快速向前移動演奏組編號，在按住

[SHIFT]按鈕的同時按下[INC/YES]按鈕。 
 若要以 10 級減小，進行相反操作，在按住[SHIFT]

按鈕的同時按下[DEC/NO]按鈕。 

3 彈奏鍵盤。 
 

演奏組名稱 
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使用分類查找功能 
方便地將演奏組分為特定類別，與所在群組的位置無
關。根據普通樂器類型或聲音特性劃分類別。分類查找
功能可讓快速找到想要的聲音。 

1 顯示演奏組播放畫面時按下[CATEGORY] 
按鈕。 
將調出分類查找畫面。 

註 
可以從觸摸演奏組名稱時調出的選單中選擇 
[Category Search]，打開分類查找畫面。 

 

 群組 

 屬性 

註 
屬性是演奏組屬性，並根據音源類型或演奏組的
聲部排序。 

 
 關鍵詞搜索 

 主類別 

 子類別 

 所選類別的演奏組列表 

註 
所選演奏組以白色顯示，具有單聲部的演奏組以
綠色顯示，具有多聲部的演奏組以藍色顯示。 

 
 用於更改排序 

 用於切換演奏組列表頁面 

 從喜愛列表添加或刪除 

2 觸摸並選擇所需主類別( )。 

註 
 通過觸摸[Bank] ( )並從列表中選擇所需群組類

型，可以過濾演奏組列表。 
 通過觸摸[Attribute] ( )並從列表中選擇所需屬性

類型，可以過濾演奏組列表。 
 也可以直接調出您喜愛的演奏組。若要進行該操

作，觸摸螢幕上的[Set] ( )，提前標記喜愛的演
奏組。 

 
 
 

3  觸摸並選擇所需子類別( )。 
將調出所選類別的演奏組列表( )。 

4 觸摸所需演奏組。 

5 觸摸 HOME 圖標或 EXIT 圖標調出所選演 
奏組。 
將關閉分類查找畫面。 

註 
您也可以使用[ENTER]按鈕、[EXIT]按鈕或 
[PERFORMANCE (HOME)]按鈕結束選擇。 
 
以下所示為類別列表及其面板縮寫。   

縮寫 類別 
Piano Piano 
Keyboard Keyboard instruments 

(Harpsichord, Clav, etc.) 
Organ Organ 
Guitar Guitar 
Bass Bass 
Strings Strings 
Brass Brass 
Woodwind Woodwind instruments 
Syn Lead Synth Lead 
Pad/Choir Synth Pad 
Syn Comp Synth Comp 
Chromatic Perc Chromatic Percussion 

(Marimba, Glockenspiel, etc.) 
Drum/Perc Drum/Percussion 
Sound FX Sound Effect 
Musical FX Musical Effect 
Ethnic Ethnic 
No Assign No Assign 
Init Initialize 

6 彈奏鍵盤。 
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選擇初始化的演奏組 
按照以下步驟選擇初始化的演奏組。 

1 在分類查找畫面中觸摸主類別的[Init]。 

2 僅初始化的演奏組顯示在演奏組列表中。 
初 始 化 的 演 奏 組 分 為 三 個 類 別 ： [Init Normal 
(AWM2)] 用 於 標 準 聲 部 (AWM2) 、 [Init Normal 
(FM-X)]用於標準聲部(FM-X)和[Init Drum]用於鼓
聲部。 

3 選擇所需演奏組。 

 
 

僅選擇單聲部演奏組 
使用屬性功能可以過濾出單聲部演奏組。 

1 在分類查找畫面中觸摸[Attribute]。 

2 從螢幕左側的選單中觸摸[Single]。 

3 僅單聲部演奏組顯示在演奏組列表中，可

以選擇所需演奏組。 

 
 
 
 
 
 
 
 
 
 
 
 

播放試聽樂句 
可以試聽演奏組聲音的樣本。樣本聲音是指 “試聽樂句”。 

1 在分類查找畫面中觸摸[Audition]。 
播放當前所選演奏組的樣本。 

 

如果在試聽樂句播放期間選擇不同的演奏組，試聽樂
句將切換到最新選擇的演奏組。 

2 再次觸摸[Audition]停止播放。 

註 
 通過按下前面板上的[AUDITION]按鈕，也可以播

放/停止試聽樂句。 
 在顯示演奏組畫面或現場設置畫面時，按下前面板

上的[AUDITION]按鈕，可以播放/停止試聽樂句。 
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彈奏鍵盤 
您可以將多個不同的聲部混合在一層中，也可在鍵盤上將其分割，甚至可以設置組合層/分割。每個演奏組最多可以包
含八個不同的聲部。演奏鍵盤前按下[PERFORMANCE (HOME)]按鈕。 
 

演奏組播放畫面 
在這種情況下，演奏鍵盤讓顯示在顯示屏中的演奏組發聲。演奏組播放畫面中顯示的參數簡要說明如下。可以通過觸
摸畫面操作圖標。 

 
 演奏組名稱 

 標記 

 分配到旋鈕的功能 

 聲部名稱 

 打開/關閉聲部的動態音序器 

 打開/關閉聲部的琶音 

 聲部的音高限制 

 打開/關閉聲部的鍵盤控制 

 打開/關閉聲部的靜音 

 打開/關閉聲部的獨奏 

 聲部 1–8 的音量 

 電平表(音頻輸出電平) 

 顯示或隱藏每個聲部的詳細信息 
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打開/關閉聲部 
您可以根據需要打開或關閉當前演奏組的八個聲部。 

打開/關閉指定聲部(靜音功能) 

通過使用靜音功能可打開/關閉單個聲部。 

1 按下[PERFORMANCE (HOME)]按鈕。 
按鈕指示燈點亮，表示各個聲部可以打開/關閉。 

 

2 觸摸螢幕上的[MUTE]按鈕對聲部靜音。 
再次觸摸相同按鈕，按鈕熄滅並取消該聲部的靜音功
能。可通過觸摸多個聲部的按鈕來打開/關閉各個聲
部。 

 
 
也可以使用[PART SELECT MUTE/SOLO]按鈕進行以下
操作使聲部靜音。 

1 當演奏組畫面顯示時，按下[PART SELECT 
MUTE/SOLO]按鈕。 
在畫面上顯示聲部選擇窗口。 

 

2 觸摸聲部選擇窗口的[MUTE]按鈕以打開按

鈕。 

3 觸摸需要靜音聲部的數字按鈕。字母 “M” 顯
示在按鈕上，靜音對應聲部。 
可通過按下多個按鈕來打開/關閉多個聲部。 

 
 
 
 
 
 

4 若要退出靜音功能，在選中 “MUTE” 的狀態

下，觸摸顯示有字母 “M” 的按鈕。 
“M”標識消失，退出靜音功能。 

 

獨奏指定聲部(獨奏功能) 

獨奏功能與靜音功能相反，可讓您立刻獨奏某個特定聲
部並使其它所有聲部靜音。 

1 按下[PERFORMANCE (HOME)]按鈕。 

2 觸摸螢幕上的[SOLO]按鈕獨奏該聲部。 
[SOLO]按鈕點亮，表示啟用獨奏。再次觸摸相同按
鈕，按鈕熄滅，退出獨奏功能。 

 
 
也可以使用[PART SELECT MUTE/SOLO]按鈕進行以下
操作獨奏一個聲部。 

1 當演奏組畫面顯示時，按下[PART SELECT 
MUTE/SOLO]按鈕。 
在畫面上顯示聲部選擇視窗。 

2 觸摸需要獨奏聲部的數字按鈕。 

3 觸摸聲部選擇窗口的 [SOLO]按鈕以打開按

鈕。 
字母 “S” 顯示在當前選中的聲部上，對應聲部獨奏。 

4 若要退出獨奏功能，在選中 “SOLO” 的狀態

下，觸摸顯示有字母 “S” 的按鈕。 
“S” 標識消失，退出獨奏功能。 
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使用琶音功能 
此功能讓您只需在鍵盤上彈奏音符，即可觸發使用當前
聲部的節奏模式、片段和樂句。 
不僅能夠為您提供現場演奏時的靈感和完整的節奏片
段，還可提供各種音樂流派的全格式樂器伴奏聲部，用
以輕鬆製作樂曲。 
您可以將所需八個琶音類型分配到各聲部並最多同時播
放八個聲部的琶音。 
您也可以設置琶音播放方式、音符範圍、力度範圍和演
奏效果，製作您自己原創的律動。 

註 
有關琶音的詳細說明，請參見參考說明書的 PDF 文件。 
 

打開/關閉琶音 

若要打開或關閉琶音播放，按下面板上的[ARP ON/OFF]
按鈕。 

 

有關在準備期間選擇不同琶音類型或在演奏途中切換琶
音的信息，請參見 “使用場景功能” (第 34 頁)。 

使用動態音序器功能 
強勁動態音序器功能可讓您根據預先創建的音序通過操
作參數動態更改聲音。 
該功能根據各個音序(如外接設備的速度、琶音或節奏)
對更改聲音提供實時控制。 
您可以對一個序列最多分配八個所需音序類型。 
您也可以對一個聲部最多設置四個對應動態音序器功能
的序列。最多八個序列可同時用於整個演奏組。 
對於動態音序器功能，除了能夠設置琶音播放方式之
外，還可以設置力度範圍、演奏效果、幅度等，製作您
自己原創的律動。 

註 
有關動態音序器的詳細說明，請參見參考說明書的 PDF
文件。 
 

打開/關閉動態音序器 

按下前面板上的[MS ON/OFF]按鈕可打開/關閉動態音序
器。 

 

有關在準備期間選擇不同動態音序器或在演奏途中切換
動態音序器的信息，請參見 “使用場景功能” (第 34 頁)。 
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使用控制器更改聲音 
MODX 提供數量驚人的控制選項。除了傳統的彎音輪和調製輪之外，還具有各種特有的實時控制──包括旋鈕、超級
旋鈕、控制滑桿和可分配開關按鈕。 

 
 

控制滑桿

超級旋鈕

旋鈕[ASSIGN 1]/[ASSIGN 2]按鈕

彎音輪

調製輪 
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使用旋鈕更改聲音 
旋鈕 1–4 (5–8)可調節當前演奏組或聲部的各個參數，如效果深度、起音/釋音特點和音質等。分配到各旋鈕的功能可
通過旋鈕功能按鈕或[ASSIGN]按鈕交替選擇。基本上有兩種方法可以控制聲音：控制整個演奏組或控制所需聲部。 

■ 對於控制整個演奏組 
將游標從演奏組播放畫面移至所需演奏組名稱。或者打開[PART SELECT MUTE/SOLO]按鈕並選擇 “Common” 
啟用演奏控制狀態，然後操作旋鈕 1–4 (5–8)。 

■ 對於控制所需聲部 
將游標從演奏組播放畫面移至所需聲部名稱。或者打開[PART SELECT MUTE/SOLO]按鈕，選擇 “1” 至 “16” 的
任意按鈕啟用聲部控制狀態，然後操作旋鈕 1–4 (5–8)。 

1 按下旋鈕功能[TONE]/[EG/FX]/[EQ]/[ARP/MS]按鈕或[ASSIGN]按鈕，使對應要切換功能的按鈕 
點亮。 

 
 [TONE]：切換到聲音設置相關功能 

 [EQ/FX]：切換到封包發生器(EQ)和效果設置相關功能 

 [EQ]：切換到均衡器(EQ)設置相關功能 

 [ARP/MS]：切換到琶音和動態音序器設置相關功能 

 
顯示當前分配到旋鈕 1–4 (5–8)的功能和功能的參數值。 

 

2 彈奏鍵盤時轉動所需旋鈕。 
對應參數的值改變並且功能/效果應用到聲音。 

 

旋鈕 1 旋鈕 2 旋鈕 3 旋鈕 4

超級旋鈕 

分配到旋鈕 1–4 (5–8)的功能。
功能的當前值 
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使用超級旋鈕更改聲音 
超級旋鈕可同時控制分配到旋鈕 1–4 (5–8)的功能的所有
參數值。將超級旋鈕和動態音序器組合使用可以生成複
雜聲音。 
超級旋鈕始終可用。使用超級旋鈕前，無需按下旋鈕功
能按鈕或[ASSIGN]按鈕。 
 

超級旋鈕設置示例 

以下是超級旋鈕設置的示例，用於將一層變形的聲音添
加至預置的超級旋鈕聲音。舉例來說，對於層，可以從
兩個預置的演奏組──原聲鋼琴和打擊板聲音中選擇，創
造出聲音變形。可以添加更加複雜的聲音到預置的超級
旋鈕。 

 

分層選擇演奏組 

1 為聲部 1 選擇演奏組。 

1-1 按下[CATAGORY]按鈕，選擇 “CFX 
PopStudioGrand”。 

2 為聲部 2 選擇演奏組。 

2-1 在演奏組播放畫面，選擇聲部 2。在按住 
[SHIFT]按鈕的同時按下[CATAGORY]按鈕，選
擇 “Ethereal”。 

3 確認當前設置。 

3-1 觸摸[Motion Control]選項分頁，然後觸摸 
[Overview]選項分頁。 
顯示動態控制概覽畫面。 

3-2 觸摸聲部的[Common]，然後觸摸[1]和[2]以確
保沒有綠線連接(換句話說，沒有分配任何內容)
至可分配旋鈕 6 和 7。 
若要查看旋鈕 5 至 8 的狀態，根據需要按下
[ASSIGN]按鈕。 

 

4 為聲部 1 設置樂器參數。 

4-1 觸摸[Super Knob]選項分頁。 
顯示動態控制超級旋鈕畫面。 

4-2 觸摸[Edit Super Knob]按鈕。 
顯示用於通用/音頻編輯的控制分配畫面。 

4-3 觸摸[+]按鈕。 
如果不顯示[+]按鈕，觸摸[>]按鈕進入第 2 頁，
然後觸摸[+]按鈕。 

 

目的地 6 已添加。 

4-4 在[Destination 6]選項分頁中，將源設為 “Asgn 
Knob 6”，將[Destination 6]設為 “Part 1 Assign 
6”。 

 

4-5 觸摸[Edit Part1 Control Settings]按鈕。 
顯示用於元素通用編輯的控制分配畫面。 

4-6 觸摸[+]按鈕。 
如果不顯示[+]按鈕，觸摸[>]按鈕進入第 2 頁，
然後觸摸[+]按鈕。 

4-7 觸摸[Destination 10]選項分頁，從聲部參數中
選擇音量。 

 

原聲鋼琴 

預置 

打擊板聲音
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4-8 如有需要，調整其他參數。 
至此，設置曲線極性(Polarity)至 “Bi”，設置曲
線率(Ratio)至 “+63”。 

 

5 為聲部 2 設置樂器參數。 

5-1 觸摸[Edit Common Control Settings]按鈕。 
顯示用於通用/音頻編輯的控制分配畫面。 

5-2 觸摸[+]按鈕。 
目的地 7 已添加。 

5-3 在[Destination 7]選項分頁中，將源設為 “Asgn 
Knob 7”，將[Destination 7]設為 “Part 2 Assign 
7”。 

5-4 觸摸[Edit Part2 Control Settings]按鈕。 
設置與聲部 1 相同的參數。 
至此，設置曲線極性(Polarity)至 “Bi”，設置曲
線率(Ratio)至 “-64”。 

 
設置完成。 

■ 如需進一步調整 
 觸摸 [Edit Common Control Settings]按鈕，在

Destination 6 和 7 之前切換，調整 Curve Type 或
Ratio。 

或 
 按下 KNOB POSITION [1]，當超級旋鈕轉動至最

左側時，轉動旋鈕 6 和 7 進行設置，並同時按下
[SHIFT]和 KNOB POSITION [1]以儲存設置。接
著，按下 KNOB POSITION [2]，當超級旋鈕轉動
至最右側時，再次轉動旋鈕進行設置，並同時按下
[SHIFT]和 KNOB POSITION [2]以儲存設置。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

確認超級旋鈕設置 

本部分包括確認通過超級旋鈕的操作更改參數值的步
驟。 

1 按下[PERFORMANCE (HOME)]按鈕。 
按鈕點亮，表示可以為所有聲部進行通用設置。 

2 在[View]按鈕關閉時，按下[ASSIGN]按鈕選擇

通用分配 1–4 或通用分配 5–8。 
當選中分配 1–4 時按鈕點亮；當選中分配 5–8 時按
鈕閃爍。 

 
顯示當前分配到旋鈕 1–4 (5–8)的功能和參數值。 

3 演奏鍵盤時轉動超級旋鈕。 
同時更改所有相關參數值，所有分配的設置應用至聲
音。 

註 
有關旋鈕分配和超級旋鈕設置的詳細說明，請參見參
考說明書的 PDF 文件。 

 

確認分配至超級旋鈕的參數 

若要確認分配至超級旋鈕的參數，打開超級旋鈕畫面。 

1 當顯示演奏組播放畫面時，觸摸畫面左側的

[Motion Control]選項分頁。 

2 觸摸畫面左側的[Super Knob]選項分頁。 
顯示超級旋鈕畫面。 

3 在超級旋鈕畫面，觸摸[Edit Super Knob]。 
顯示控制分配畫面。 

 
您可以在一個頁面中查看超級旋鈕的詳細資訊。如有
需要，進行調整。 
 

註 
首 先 觸 摸 畫 面 左 側 的 [Control] 選 項 分 頁 ， 然 後 觸 摸
[Control Assign]選項分頁，可從演奏組編輯畫面打開控
制分配畫。 
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使用踏板控制器控制超級旋鈕 
您可以用踏板控制器(FC7)控制超級旋鈕。 

1 將踏板控制器(FC7)連接到 FOOT 
CONTROLLER [1]/[2]插孔。 

2 將游標移至演奏組播放畫面上的演奏組名

稱，然後按下[EDIT]按鈕。 

3 觸摸螢幕左側的[Control]選項分頁 →  
[Control Number]選項分頁。 

4 將 “Foot Ctrl 1” 或 “Foot Ctrl 2” 設置為 
“Super Knob” ──具體視連接踏板控制

器(FC7)的插孔而定。 

混音 
每個混音最多可以包含 16 個聲部，並且可以對每個聲部
創建獨立的混音。您可以調節每個聲部的各個混音相關
參數：音量、聲像等。 
 

混音的基本步驟 

1 觸摸演奏組播放畫面左側的[Mixing]選項分

頁。 
顯示混音畫面。 

 
 各聲部的主類別 

 在 3 頻段 EQ/2 頻段 EQ 之間切換畫面 

 各聲部的 EQ 設置 

 各聲部的參數值 

 更改聲部 1–16 的畫面 

 更改音頻聲部(不顯示聲部 9–16)的畫面 

2 按下[PART SELECT MUTE/SOLO]按鈕 → 
[1]–[16]按鈕選擇想要調節參數值的聲部。 

註 
通過觸摸螢幕上的[Audio] ( )，顯示音頻聲部。您
可以設置與從 A/D INPUT [L/MONO]/[R]插孔輸入的
音頻數據(AD 部分)和從[USB TO HOST]端子輸入的
音頻數據(數字部分) *相關的參數。 

 
* 設備端口中設置為 “Digital L/R” 的音頻數據 

3 將游標移至各聲部的參數並通過轉動數據輪

更改參數值。 

註 
 有關更多詳細參數設置，按下混音畫面中的[EDIT]

按鈕打開編輯畫面。 
 有關混音參數和混音編輯的詳細說明，請參見參考

說明書的 PDF 文件。 
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使用場景功能 
您可以將琶音類型、動態音序器類型和聲部參數值等所
有參數設置作為 “場景” 儲存在一起。有八個場景，您可
以按下[SCENE]按鈕進行選擇。 
對於播放單個演奏組時，同時大幅更改琶音類型和動態
音序器類型很有用。 
 

更改場景設置 

1 觸摸演奏組播放畫面左側的 [Scene]選項分

頁。 
顯示場景畫面。 

 

 在場景 1 – 8 之間切換 

 打開/關閉各場景的功能 

 打開/關閉所有聲部的動態音序器 

 當前所選場景的動態音序器類型 

 打開/關閉所有聲部的琶音 

 當前所選場景的琶音類型 

註 
僅當在部分 2 選擇 “Arp” 和 “Motion Seq” 時，才會
顯示部分 3 至部分 6 (參見上圖)。 

2 根據需要設置場景 1–8。 
當打開功能、動態音序器類型或琶音類型的[Memory]
時 ， 對 應 的 功 能 信 息 將 自 動 儲 存 到 當 前 所 選 的
[SCENE]按鈕。通過按下 SCENE [1]–[8]按鈕之一，
將切換場景 1–8，並且恢復各場景的儲存信息。 

註 
您也可以從任何其他操作畫面更改場景設置。使用旋
鈕從其他設置畫面更改參數或使用之前已分配參數
的控制滑桿從場景設置畫面更改參數後，在按住
[SHIFT]按鈕的同時按下 SCENE [1]–[8]按鈕之一儲
存設置。 

 
 
 
 
 
 
 
 

3  根據需要儲存演奏組(第 37 頁)。 

須知 
如果您在未儲存已編輯演奏組的情況下選擇另一個

演奏組或關閉電源，則清除對場景所作的所有編輯操

作。 
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創建自己的現場設置 
現場設置適用於現場演奏組環境，可讓您在所需演奏組中即時切換。只需將喜愛的演奏組歸在一起，即可創建自己的
現場設置。 
 

將演奏組註冊到現場設置 
按照以下說明將演奏組儲存到現場設置。 

須知 
 將當前正在編輯的演奏組儲存到現場設置之前，先儲

存演奏組(第 37 頁)。 
 如果在未儲存已編輯演奏組的情況下選擇另一個演

奏組或關閉電源，則清除所有編輯操作。 

1 選擇要使用的演奏組。 

2 按住[SHIFT]按鈕並按下[LIVE SET]按鈕。 
顯示現場設置畫面。 

 

3 觸摸其中一個插槽。將當前所選的演奏組註冊

到該插槽。 

 

 
 
 
 
 
 
 
 
 
 
 

分類現場設置中已註冊的演奏組 
可在現場設置編輯畫面上更改註冊到現場設置的演奏組
的順序。 

1 顯示現場設置畫面時按下[EDIT]按鈕。 
顯示現場設置編輯畫面。 
(如果預置群組/資料群組的現場設置已打開，將不會
顯示現場設置編輯畫面。) 

2 選擇包含要移動的演奏組的插槽並觸摸螢幕

上的[Swap]。 
[Swap]點亮，既可以更改插槽。 

 

3 選擇所需目的地插槽。 
原始插槽和目的地插槽相互切換。 

 

現場設置畫面 

空插槽註冊到插槽中的演奏組 
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使用腳踏開關切換現場設置中儲存的演奏組 
您可以使用連接的腳踏開關(FC4 或 FC5)切換演奏
組。該操作設置如下。 

1 將腳踏開關(FC4 或 FC5)連接到 FOOT 
SWITCH [ASSIGNABLE]插孔。 

2 按下[UTILITY]按鈕調出工具畫面，然後觸

摸螢幕左側的 [Settings] 選項分頁  → 
[MIDI I/O]選項分頁。 

3 將 “FS Assign” 設置為 “Live Set+” 或 
“LiveSet -”。 
選擇 “Live Set +” 時，以正序切換演奏組。選擇 
“Live Set -” 時，以倒序切換演奏組。 
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編輯設置 
本樂器具有各種針對聲部、演奏組、效果和琶音的編輯畫面。本章節說明如何通過組合多個聲部創建原創演奏組。 
 

演奏組編輯 
“演奏組編輯” 是指通過更改組成演奏的參數的演奏組創
建過程。可以在演奏組編輯畫面進行此操作。 

編輯演奏組的基本操作 

1 將游標移至演奏組播放畫面上的演奏組名

稱，然後按下[EDIT]按鈕。 

2 觸摸螢幕左側的[General]選項分頁編輯演奏

組。 

 

儲存演奏組(儲存) 

編輯後，將演奏組儲存到內存。 
按下[STORE]按鈕儲存演奏組。 

須知 
 選擇另一個演奏組或關閉電源時，已編輯的演奏組將

丟失。 
 如果覆蓋用戶群組中的演奏組，將被永久刪除。當儲

存已編輯的演奏組時，注意不要覆蓋任何重要的用戶

演奏組。重要數據務必儲存在連接到 [USB TO 
DEVICE]端口的 USB 隨身硬碟。有關儲存的詳細說

明，請參見第 60 頁。 

註 
演奏組編輯期間，可以使用[PART SELECT MUTE/ 
SOLO]按鈕選擇任何所需聲部並編輯所選聲部。 
 
 
 
 
 
 
 
 
 
 
 
 

1 按下[STORE]按鈕調出儲存畫面。 

 

2 設置儲存演奏組的目的地。 
若要儲存新 編輯的演奏 組，觸摸 [Store As New 
Performance]部分中的 “+”。 

註 
若要覆蓋之前儲存的演奏組，觸摸[Overwrite Current 
Perf.]或要覆蓋的演奏組。 

3 顯示文本輸入畫面。輸入已儲存演奏組的名

稱。 
有關輸入字符的詳細說明，請參見 “基本操作和顯示
畫面” 中的 “命名(輸入字符)” (第 21 頁)。 

4 選擇文本輸入畫面上的 “Done” 實際執行儲

存操作。 

註 
如果正在覆蓋之前儲存的文件，步驟 2 之後會出現確
認畫面。選擇 “YES” 執行儲存操作。 

 

演奏組編輯畫面 
之前儲存的演奏組 

正在儲存新演奏組 
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聲部編輯 
“聲部編輯” 是指通過更改組成聲部的參數的聲部創建過
程。可以在元素通用/鍵通用/操作器通用編輯畫面和元素
/鍵/操作器編輯畫面進行此操作。可用的實際參數因聲部
類型而異。 
 

標準聲部(AWM2)編輯 

標準聲部(AWM2) (具有音高的樂器聲音)最多可包含八
個元素。元素是聲部的基礎，是最小單位。有兩種類型
的標準聲部(AWM2)編輯畫面：用於編輯所有八個元素通
用設置的元素通用編輯畫面和用於編輯單個元素的元素
編輯畫面。 
 

通過將各個參數(效果、EG 等)應用到樂器聲音的波形
創建元素。本樂器的標準聲部(AWM2)最多包含八個
元素。 

 

標準聲部(FM-X)編輯 

標準聲部(FM-X) (分配的 FM-X 聲音)最多可包含八個操
作器。有兩種類型的標準聲部(FM-X)編輯畫面：用於編
輯所有八個操作器通用設置的操作器通用編輯畫面和用
於編輯單個操作器的操作器編輯畫面。 
 

FM-X 的縮寫 “FM” 代表 “頻率調製”，是使用一個波
形的頻率調製另一個波形從而產生全新波形的特殊
音源系統。通過 MODX 的八個 “操作器” 產生波形。
產生基本波形的操作器是 “載波”，調製這些波形的操
作器是 “調製器”。八個操作器均可用作載波或調製
器。通過更改操作器組合的方式並控制電平和封包等
其他參數調製，能夠以高度複雜的方式生成層次豐富
的聲音。 

 

 
 
 
 
 
 
 

鼓聲部編輯 

有兩種類型的鼓聲部編輯畫面：用於編輯應用到所有鼓
鍵設置的鍵通用編輯畫面和用於編輯單鍵設置的鍵編輯
畫面。 
 

鼓聲部主要是分配到單鍵的打擊樂/鼓聲。通過更改分
配的聲音類型以及調節音高和 EQ，可以創建多個鼓
聲部。 
本樂器的鼓聲部最多包含 73 鍵。 

 

聲部編輯的基本操作 

1 將游標移至想要在演奏組播放畫面上編輯的

聲部，然後按下[EDIT]按鈕。 
也可以使用[PART SELECT MUTE/SOLO]按鈕選擇
一個聲部。 

2 觸摸螢幕左側的[Part Settings]選項分頁 → 
[General]選項分頁編輯所需聲部。 

■ 對於標準聲部(AWM2) 
對於元素通用編輯，觸摸元素的[Common]選項分頁。 
對於元素編輯，從[Elem1]-[Elem8]選項分頁中按下要
編輯元素的對應數位按鈕。 

■ 對於鼓聲部 
對於鍵通用編輯，按下鼓鍵的[Common]選項分頁。 
對於鍵編輯，按下要編輯鼓聲部(BD、SD 等)的對應
選項分頁。 
使用[BD]–[Crash]選項分頁可以切換各個樂器聲音
(分配到 C1 至 C#2)的鍵。若要選擇分配到 C1 至 C#2
以外的鍵，打開畫面上的 “Keyboard Select” 並彈奏
分配到要編輯按鍵的音符。 

■ 對於標準聲部(FM-X) 
對於操作器通用編輯，觸摸操作器的[Common]選項
分頁。 
對於操作器編輯，從[OP1]–[OP8]選項分頁中按下要
編輯操作器的對應數字按鈕。 

註 
有關聲部參數的詳細說明，請參見參考說明書的 PDF
文件。 

 

聲音輸出

已調製的波形 要調製的波形 

載波 

調製器 
當調製器的音量增加
時，載波波形將改變。
* 當音量為 0 時，載波

波形不受影響。 

正在調製的波形 
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■ 元素通用編輯畫面 

 

畫面結構與鍵/操作器通用編輯畫面相同。 

■ 元素編輯畫面 

 

畫面結構與鍵/操作器編輯畫面相同。 

3 根據需要儲存演奏組。 

聲部效果編輯 
本樂器具有各種類型的效果，可在鍵盤演奏的所選聲部
中加入變化和殘響。只需更改應用到預置聲部的效果類
型，即可立刻呈現不同聲音。以下說明介紹如何設置應
用到聲部的效果類型和相關參數，然後將設置作為用戶
演奏組儲存。 

1 將游標移至演奏組播放畫面上要編輯的聲

部，然後按下[EDIT]按鈕。 

2 觸摸元素[Common]按鈕。 

3 觸摸螢幕左側的[Effect] → [Routing]選項分

頁。 
顯示用於元素通用編輯的效果畫面。 

 
 各元素/鍵的輸出 

 插入效果 A 的類別 

 插入效果 A 的類型 

 插入效果 A 的預置 

 插入效果 A 和 B 之間的連接方法 

 側鏈/調製器的選擇 

4 設置各元素/鍵的輸出( )。 

5 選擇對應插入效果 A 的參數(效果類別( )、
效果類型( )和效果預置( ))。 

6 設置插入效果 A 和 B 之間的連接方法( )。 

7 設置插入效果 B 的側鏈/調製器( )。 

註 
側鏈/調製器使用來自一個音軌的輸出控制不同音軌
中的效果。可以指定用於啟用功能的效果類型，使非
選聲部的輸入信號或音頻輸入信號能夠控制指定效
果。 
根據效果類型不同，此觸發器稱為 “側鏈” 或 “調製
器”。 

 
 
 
 
 
 
 

表示啟用元素通用編輯畫面。 

在元素通用編輯和元素編輯之間切換。 

表示啟用元素編輯畫面。 
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8 觸摸螢幕左側的[Ins A]選項分頁。 
顯示用於編輯步驟 4 中所選效果參數的畫面。 

 

9 根據需要設置參數。 
精確編輯每個效果類型的參數可縮小所需要聲音的
範圍。 

 

比較功能 
比較功能可在剛編輯的聲音和原始、未編輯狀態之間
切換，以便試聽編輯效果。 
 
顯示編輯畫面時按下[EDIT]按鈕，使[EDIT]按鈕閃
爍。在此狀態下，編輯之前的聲音設置將暫時保留，
以便比較。再次按下[EDIT]按鈕可以返回原始狀態。

 

10 使用相同操作編輯插入效果 B。 

11 根據需要存儲演奏組。 

聲部如何分配到演奏組 
默認情況下(出廠時)，預置群組中提供演奏組的各種類
型。對於某些演奏組，由於非常複雜，用戶可能無法立
即明白如何彈奏或使用。在本章節中，您將了解創建演
奏組的典型方法，隨後您便能掌握播放和使用演奏組的
方法。本章節包含典型的四個聲部分配。 
 
 

演奏組結構 層 
 
此方法可讓您通過按下任意音符同時彈奏多個(兩個或更
多)聲部。 
例如：通過合併兩個相似聲部(如兩個不同的弦樂聲部，
每個聲部的起音速度不同)創建更加渾厚的聲音。 

 

演奏組結構 按音符範圍進行分區 
 
此方法可讓您用左手和右手彈奏不同的聲部。通過如下
所示分別將弦樂聲部分配到較低範圍並將笛管分配到較
高範圍，您可以用左手彈奏弦樂伴奏，同時用右手彈奏
笛管旋律。 

 

演奏組結構 按力度範圍進行分區 
 
此方法可讓您根據彈奏力量(力度)觸發不同聲部。在以下
示例中，以低力度彈奏音符將觸發起音速度慢的弦樂聲
音。以中等力度彈奏音符將觸發起音速度快的弦樂聲
音。以高力度彈奏音符將觸發管弦樂齊奏。 

 
 
 
 
 
 
 
 
 

聲部

聲部

笛管 

起音速度慢的弦樂 

聲部 1 聲部 2 

弦樂

起音速度快的弦樂 

聲部 3
聲部 2
聲部 1

管弦樂齊奏 
起音速度快的弦樂 
起音速度慢的弦樂 

力度
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演奏組結構 使用琶音 
 
使用此方式，您可獨自彈奏一個樂隊的所有聲部。通過
MODX，您可以在演奏中分配不同的琶音類型至八個聲
部的每一個。例如，可以分配四種不同的琶音類型至四
個聲部，如下圖所示，在鍵盤低音範圍內演奏貝司琶音，
在中高音範圍內演奏吉他和鋼琴琶音，在鍵盤所有範圍
內演奏鼓琶音。然後，只需彈奏鍵盤上的適當區域，您
可以添加全動態伴奏至演奏中。 
另外，可以從畫面[Motion Control] → [Arpeggio]更改琶
音類型分配，這樣就可以為樂曲的前奏、主歌、副歌和
尾聲設置不同琶音。 

 
使用或組合上述 4 種方式可創建種類豐富的演奏組。默
認情況下，已通過以上方法創建預置群組中儲存的多個
演奏組。試著使用各種演奏組並判斷每種演奏組使用何
種方式。 

通過合併聲部創建演奏組 
在預置群組中查看預編制的演奏組之後，嘗試創建原創
演奏組。在本章節中，我們將通過合併兩個聲部創建演
奏組。 

選擇演奏組 

為了演示，我們將鋼琴聲音分配到聲部 1。 

1 將游標移至演奏組播放畫面上聲部 2 的聲部

名稱，並在按住 [SHIFT]按鈕的同時按下

[CATEGORY]按鈕選擇所需聲音。 
顯示聲部分類查找畫面。 

2 從演奏組列表中選擇[Full Concert Grand]。 

3 按下[EXIT]按鈕。 

同時彈奏數個聲部(層) 

嘗試通過將喜愛的聲部分配到聲部 2 組合兩個聲部。 

1 將游標移至演奏組播放畫面上聲部 2 的聲部

名稱，並在按住 [SHIFT]按鈕的同時按下

[CATEGORY]按鈕選擇所需聲音。 

2 彈奏鍵盤。 
聲部 1 (鋼琴)和聲部 2 (上述選擇的聲音)在一層中同
時響起。 

3 按下[EXIT]按鈕。 
 
接下來，讓我們用左手和右手彈奏不同聲部。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

聲部 3具有琶音的吉他 

琶音保持設置為 ON 的鼓 
聲部 4
聲部 1

聲部 2 具有琶音的貝司 具有琶音的鋼琴 
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分割 

音符範圍在鍵盤低音區時將一個聲部分配到聲部 1，音符
範圍在鍵盤高音區時將另一個聲部分配到聲部 2，如此即
可用左手和右手彈奏不同的聲部。 

 

 音高下限(該聲部範圍的最低音符) 

 音高上限(該聲部範圍的最高音符) 

1 觸摸聲部1的音高上限( )或將游標移至 並

按下[ENTER]按鈕。 

2 觸摸螢幕左側的[Keyboard]選單將其打開。 

3 按下對應鍵設置聲部 1 的最高音符。 
聲部 1 的 Range 部分中的音符編號改變。 

4 觸摸聲部2的音高下限( )或將游標移至 並

按下[ENTER]按鈕 

5 按下對應鍵設置聲部 2 的最低音符。 
聲部 2 的 Range 部分中的音符編號改變。 

6 觸摸螢幕左側的[Keyboard]選單將其關閉。 

7 彈奏鍵盤。 
用左手彈奏的音符發出鋼琴聲部(聲部 1)的聲音，用
右手彈奏的音符發出所選其他聲部(聲部 2)的聲音。 

 

8 按下滑桿功能[PART]/[ELEMENT/ 
OPERATOR] 
按鈕選擇 “PART”。 

9 使用控制滑桿 1 和 2 調節聲部 1 和 2 的音量。 
 

將分割聲部的音符範圍更改為低一個八度 

將聲部 2 的音符範圍更改為低一個八度。 

1 將游標移至聲部 2 並按下[EDIT]按鈕進行聲

部編輯。 

2 觸摸螢幕左側的 [Part setting]選項分頁  → 
[Pitch]選項分頁。 

 

3 選擇 “Note Shift” 調節音高。 
以半音為單位切換音高。設置 “-12” 可使音符範圍低
一個八度。 

4 彈奏鍵盤。 
 

改變每個聲部的琶音設置 

試著改變每個聲部的琶音設置。您可將最適合所需音樂
風格的節奏或伴奏模板分配到演奏組。 

1 將游標移至聲部 1 並按下[EDIT]按鈕調出元

素通用編輯畫面。 

2 觸摸螢幕左側的 [Arpeggio]選項分頁  → 
[Common]選項分頁(畫面頂部附近)。 
顯示用於設置所有琶音類型的通用琶音參數畫面。 
請註意，琶音 Hold 參數和琶音類型選擇一樣有用。
當此參數設置為 “on” 時，即使放開音符鍵，琶音播
放仍將繼續。當鼓聲音分配到聲部，並且無論是否保
持音符均要持續播放琶音(節奏模板)時，此參數應設
置為 “on”。 

 
 
 
 
 
 

聲部 1：鋼琴聲部 聲部 2：其他聲部

音高切換
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3 觸摸[Individual]選項分頁調出各琶音類型的

設置畫面。 

4 觸摸琶音類型並選擇螢幕左側的 [Category 
Search]選單。(或者，可以按下[CATEGORY]
按鈕。) 
類別決定樂器類型，而子類別決定音樂類型。 
琶音類型包括樂曲每個樂章的變形，如前奏、主歌、
副歌、合唱和銜接段。彈奏鍵盤，試聽琶音，選擇一
個喜歡的類型。 

 
繼續操作並根據需要以相同的方法分配其他琶音類
型。 

5 根據需要儲存演奏組。 

使用節奏模式 

[Rhythm Pattern]按鈕可輕鬆將節奏聲部添加至當前演
奏組。 
通過結合節奏模式和封包跟隨器，可以進一步修改模式
組。 
 
在此作為示例，我們介紹如何添加節奏模式 “8Z Trance 
Basics 1” 至演奏組 “Supertrance” 中，以及如何通過封
包跟隨器修改聲音。 
 

添加節奏聲部(簡單方法) 

1 選擇需要的演奏組用於添加節奏聲部。 
此處選擇 “Supertrance”。 

2 按下[RHYTHM PATTERN]按鈕。 
顯示節奏模式畫面。 
當聲部 1 至 8 的所有聲部都處於使用中時，顯示信息
“Part Full” (聲部已滿)，節奏模式無法被添加。 

 

 群組/喜愛 

 名稱搜索 

 組選擇 

 靜音 

 分類 

 切換頁面 

3 從節奏模式列表中觸摸想要使用的節奏模式

組。 
此處，觸摸 “8Z Trans Basics1”。 
一個節奏聲部被添加。 

4 彈奏鍵盤，節奏模式開始播放。 
 
 
 
 
 
 
 
 
 

[Common]選項卡 

琶音類型的設置
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5 按 下 [PERFORMANCE (HOME)] 按 鈕 或

[EXIT]按鈕設置節奏模式。 
節奏模式畫面關閉。 

註 
您也可以觸摸 HOME 圖標確認選擇。 

6 若要停止節奏模式，按下[ARP ON/OFF]按鈕

或[ ] (停止)按鈕。 

註 
您也可以通過觸摸畫面上的[Arp Hold On]按鈕停止
節奏模式。 

設置封包跟隨器 

封包跟隨器是一種從輸入信號中提取波形封包(或振幅封
包)的功能，然後使用該封包作為控制器來修改聲音。例
如，通過將一個節奏模式分配給聲部，然後將該聲部的
封包跟隨器設置為一個 “源”，其他聲部的聲音也將相應
地被修改。當播放某個樂器聲音的同時，想要降低其他
樂器的音量時，該功能對此類自動 “閃避” 特別有用。 

1 觸摸節奏模式畫面底部的[Envelope Follower]
選項分頁。 
顯示封包跟隨器畫面。 

 

2 將封包跟隨器開關設為 “ON”。 
在此，可以彈奏鍵盤，試聽封包跟隨器啟動後的聲音。 

 

 
 
 
 
 
 
 
 

3  根據需要調整設置。 
在本示例中，設置曲線極性(Polarity)至 “Bi”，曲線率
(Ratio)至 “-63”，增益(Gain)至 “-12dB”。 

 

對於其他參數的設置，觸摸螢幕中的[EDIT]按鈕，打
開封包跟隨器設置畫面。 

 
當想要更改節奏模式組或琶音類型時，按下[RHYTHM 
PATTERN]按鈕返回節奏模式畫面。即便已選擇新組或琶
音類型，封包跟隨器的設置仍將保留。 
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錄音和播放 
您可以將 MIDI 數據作為樂曲錄製在本樂器或將演奏組(音頻數據)錄製到插入 MODX 的 USB 隨身硬碟。 
 

術語 

樂曲 
本樂器上的樂曲與 MIDI 音序器上的樂曲實際是相同的，
並且在錄製數據結束時播放自動停止。MODX 最多可以
儲存 128 首樂曲。 

音軌 
音軌是音序器上的儲存位置，可儲存您的音樂演奏(由
MIDI 事件組成)數據。MODX 提供 16 個音軌，與 16 個
混音聲部對應。 

實時錄製 
當隨節拍器彈奏時，本樂器錄製演奏組數據。實時錄製
有三個可用方法：Replace、Overdub 和 Punch In/Out。 
 Replace 可讓您用新數據覆蓋已錄製的音軌，刪除之

前錄製的數據。 
 Overdub 可讓您將更多數據添加到已包含數據的音

軌──將新的音符錄製在之前音符之上。 
 Punch In/Out 可讓您有選擇性地重新錄製音軌的指

定部分。 
 
 
 

MIDI 錄音 
本樂器具有用於將鍵盤演奏組錄製為 MIDI 數據的演奏組
錄製器(內建多音軌音序器)。此功能可讓您立即儲存浮現
於腦海的樂句。您可以使用 DAW 創建完整複雜的多樂器
編曲和完整樂曲。 

錄製到音軌 

在本節中，您將了解如何通過將聲部錄製到音軌 1 來錄
製鍵盤演奏。但是，首先需要設置用於錄製的 MODX。 

1 觸摸演奏組播放畫面左側的[Play/Rec]選項分

頁。 
顯示錄製畫面。 

2 觸摸螢幕左側的[MIDI]選項分頁。 

3  按下[ ] (錄音)按鈕。 
顯示錄音設置畫面。 

註 
或者，您只需按下演奏組畫面中的[ ] (錄音)按鈕，
立即執行步驟 1–3。 

 

 樂曲名稱 

 當前所選的演奏組名稱 

 拍號(拍子) 

 位置(錄製/播放的起始位置) 

 量化 

 對應整個音序的位置 

 整個音序的錄製時間 

 各音軌播放打開/關閉 

 快捷方式至速度設置畫面 

 改變速度 

4 在錄音設置畫面中設置下列參數。 

4-1 將游標移至 Time Signature (拍子) ( )，然後
設置值。對於本示例，將其設置為 “4/4”。 

4-2 在 Record Quantize ( )中將量化設置為 “240 
(8th note)”。此項方便實用的功能可讓您在錄音
時自動實時量化音符(或 “清理” 其節拍)。量化
將音符事件的時序與最接近的節拍對準。通
常，應設置音符中最小音符值(如果從樂譜彈
奏)。 

5 完成錄製設置後，按下[ ] (播放)按鈕開始錄

製。 
按下[ ] (播放)按鈕，然後在計時後開始錄製。 

6 彈奏結束後，按下[ ] (停止)按鈕停止錄製。 
如果彈錯音符，按下[ ] (停止)按鈕，然後再次錄製。 
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以節拍錄製 
按照下列步驟在 MIDI 錄音期間使用節拍。 

1 按 下 [UTILITY] 按 鈕 並 觸 摸 螢 幕 上 的

[Tempo Settings] (或如果可用，觸摸[Click 
Settings]按鈕 )調出速度設置畫面。將 
“Mode” 設置為 “Rec”。 

註 
設置為 “Rec/Play” 時，節拍在 MIDI 錄音和播放期間
發出聲音。設置為 “Always” 時，節拍始終發出聲音。

 
 

重錄樂曲的指定部分(Punch In/Out) 
使用 Punch In/Out 錄製方法僅錄製音軌的指定部
分 。 如 果 設 置 開 始 點 (Punch In)和 結 束 點 (Punch 
Out)，然後從樂曲的開頭開始錄製，將僅在 Punch In
和 Punch Out 點之間進行實際錄製。在以下八小節示
例中，僅重錄第三至第五小節。 

 

註 
請註意 Punch In/Out 錄製方式總在一定區域替代原
始數據。 
 
若要在上述情況中執行 Punch In/Out 錄製，需要預先
在錄音設置畫面上設置以下參數。 

 “Record Type”：“punch” 

 Punch In：003:01 

從該點關閉錄製音軌的播放，且鍵盤演奏將被錄
製到音軌。 

 
 
 

 Punch Out：006:01 

在該點結束錄製，且開始正常播放錄製音軌。 

 

 
 

取消最近錄製(撤銷/恢復) 
撤銷作業將取消在最近錄製片段中所做的更改，並將
數據恢復為之前狀態。重做命令僅在使用撤銷命令後
有效，可以讓您恢復為使用撤銷命令前的改變狀態。
 

 撤銷(如果未進行錄製，此畫面不可用。) 
觸摸[Undo]時，畫面提示確認。選擇撤銷將取消
之前的錄製。 

 

 恢復(如果未進行撤銷操作，此畫面不可用。) 
觸摸[Redo]時，畫面提示確認。選擇恢復將恢復
所做的更改。 

 

 
 

重錄之前 
錄製開始 錄製停止 

Punch In 點 Punch Out 點 

重錄之後 

新錄製數據 
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播放樂曲 
在本章節中，您將了解如何在播放錄製樂曲時使用方便
的靜音/獨奏功能。 
 

樂曲播放 

1 按下[ ] (播放)按鈕開始播放樂曲。 

 

註 
若要調節樂曲的音量，使用[MASTER VOLUME]旋
鈕。 

2 按下[ ] (停止)按鈕停止樂曲。 
 

調節各聲部的音量 

您可以使用控制滑桿調節四個聲部的音量。 

 

首先按下 [PART]/[ELEMENT/OPERATOR]按鈕選擇聲
部，然後按下滑桿選擇[1–4] [5–8]按鈕，就可以更改聲部
5–8 的音量。 
 
除了滑桿之外，旋鈕 1–4 (5–8)可用於實時影響樂曲播放
的聲部設置。有關詳細說明，請參見參考說明書的 PDF
文件。 

將您的演奏錄製為音頻 
MODX 上的演奏可作為 WAV 格式(44.1-kHz，24 位，立
體聲)音頻文件錄製到 USB 隨身硬碟。錄製電平固定，最
多可以持續錄製 74 分鐘(假定 USB 儲存設備可用儲存空
間充足)。 

須知 
錄製、播放期間或正在儲存錄製的音頻文件時，切勿關

閉 MODX。此時關閉 MODX 可能導致無法繼續訪問 USB
隨身硬碟。 

1 將 USB 隨身硬碟連接到 MODX 的[USB TO 
DEVICE]端口。 

2 觸摸演奏組播放畫面左側的[Play/Rec]選項分

頁。 
顯示錄製畫面。 

3 觸摸螢幕左側的[Audio]選項分頁。 

4 按下[ ] (錄音)按鈕設置音頻錄音。 
顯示錄音設置畫面。 

 

 播放位置 

 整個音頻數據中的當前播放位置 

 可用錄製時間 

 電平表 

 觸發電平 

5 設置所需觸發電平( )。 
如果將觸發電平設置為 “manual”，只要按下[ ] (播
放)按鈕，即開始錄製。如果設置了 1–127 之間的數
值，則當播放音量超出時，自動開始錄製。此處設置
的電平將在電平表( )中以藍色的三角形表示。為獲
得最佳效果，應將此參數設置為可能的最低值以捕捉
整體信號，但是不能低到錄製干擾噪音。 

 
 
 
 
 
 
 
 
 
 

停止 播放 

[PART]/[ELEMENT/OPERATOR]按鈕 

滑塊選擇[1–4] [5–8]按鈕 
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6 按下[ ] (播放)按鈕。 
如果已將觸發電平設置為 “manual”，按下[ ] (播放)
按鈕之後，立即開始錄製。錄製時，[ ] (錄音)按鈕
將以紅色點亮，而[ ] (播放)按鈕將以綠色點亮。如
果已設置 1 和 127 之間的值作為觸發電平，只要播
放音量超過該值，自動開始錄製。 

7 彈奏鍵盤。 
如果將觸發電平設置為 1 和 127 之間的值，只要播
放音量超過該值，自動開始錄製。 

8 彈奏結束後，按下[ ] (停止)按鈕。 
錄製的音頻文件將儲存在所選設備中。 

播放音頻文件 
如下所述，MODX 可以播放來自 USB 隨身硬碟的音頻文
件(.wav)，無論是由樂器本身創建，還是來自其他源。 

1 將 USB 隨身硬碟連接到 MODX 的[USB TO 
DEVICE]端口。 

2 觸摸演奏組畫面左側的[Play/Rec]選項分頁 
→ [Audio]選項分頁。 

3 觸摸 “Audio Name”，然後選擇螢幕左側的

[Load]選單。 

4 選擇源 USB 隨身硬碟和文件夾。 

5 選擇 USB 隨身硬碟上的所需文件(.wav)執行

加載操作。 

 

 音頻名稱 

 音頻音量 

 音頻長度 

6 按下[ ] (播放)按鈕。 
音頻文件開始播放。 

7 將游標移至 “Audio Volume” ( )，然後使用

數據輪調節播放音量。 

8 按下[ ] (停止)按鈕停止播放。 

註 
請切記，音頻播放期間，也可以在鍵盤上彈奏所選的
演奏組。 
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用作主控鍵盤 
主控鍵盤功能最多可在每個演奏組中分配八個獨立的區域，用作主控鍵盤控制器。 
可以通過與現場設置組合使用，隨時調出用於控制外接 MIDI 設備的設置。因此，現場演奏時也可以按順序更改並控
制外接 MIDI 音源。 
 

用作主控鍵盤的設置——分區 
將 MODX 用作主控鍵盤時，最多可以將鍵盤分為八個獨
立的區(稱為 “分區” )。不同的 MIDI 通道以及旋鈕和控制
滑桿的不同功能可分配到各個分區。由此通過一個鍵盤
即可同時控制內建複合音色音源的多個聲部，或在多個
不同通道上控制外接 MIDI 樂器的演奏組以及本合成器的
內建演奏組——使用 MODX 可有效進行多個鍵盤的工
作。可以設置八個分區相關的參數並儲存設置。 
 
首先，通過啟動分區設置將 MODX 設為主控鍵盤。 

1 按下[UTILITY]按鈕調出工具畫面。 

2 觸摸螢幕左側的 [Settings] 選項分頁  → 
[Advanced]選項分頁。 

3 觸摸[Zone Master]將其打開。 

 

4 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

接下來，根據主控鍵盤(分區)對各個演奏組進行設置。 

1 按下[PERFORMANCE (HOME)]按鈕調出演

奏組播放畫面。 

2 將游標移至當前所選演奏組的所需聲部並按

下[EDIT]按鈕進行編輯。 

3 觸摸螢幕左側的[Part Settings]選項分頁 → 
[Zone Settings]選項分頁。 

4 觸摸[Zone]將其打開。 

5 設置分區相關參數，如 MIDI 發送通道和音符

限制。 

 

6 觸摸[Zone Transmit]選項分頁根據需要設置

發送開關。 

 

完成設置後，按下[STORE]按鈕儲存演奏組。 
 
有關分區設置的詳細信息，請參見參考說明書的 PDF 文
件。 
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連接麥克風或音頻設備 
 

隨著 A/D INPUT [L/MONO]/[R]插孔輸

入的聲音彈奏鍵盤 
可以將 A/D 輸入聲(如通過麥克風、CD 播放機或合成器
的聲音)作為音頻輸入聲部進行分配。音量、聲像和效果
等各參數可設置到此聲部，且與鍵盤演奏的聲音一起輸
出。 

1 確保關閉本樂器的電源並將 A/D INPUT 
[GAIN]旋鈕設置到最小。 

2 將音頻設備或麥克風連接到後面板的 A/D 
INPUT [L/MONO]/[R]插孔。 

 

註 
推薦使用標準動態麥克風。(本樂器不支援幻象供電
的電容麥克風。) 

3 打開連接的音頻設備，然後打開 MODX。 

4 按下[UTILITY]按鈕調出工具畫面，然後觸摸

螢幕左側的[Settings]選項分頁 → [Audio I/O]
選項分頁。 

5 根據連接到 A/D INPUT [L/MONO]/[R]插孔的

各個設備設置 “Mic/Line” 參數。 
連接麥克風等低輸出電平的設備時，將此參數設置為 
“Mic”。連接高輸出電平的設備(如合成器鍵盤、CD
播放機、便攜式音樂播放器)時，將此參數設置為 
“Line”。 

6 按下 A/D INPUT [ON/OFF]按鈕使其指示燈

點亮。 
此設置啟用來自連接的音頻設備的輸入音頻信號。 

 

7 使用[GAIN]旋鈕調節輸入電平。 

註 
使用[GAIN]旋鈕調節輸入電平，使 PEAK LED 指示
燈僅在輸入聲最響時短暫點亮。 

 

8 按下[PERFORMANCE (HOME)]按鈕，然後

選擇所需演奏組。 
當對著麥克風唱歌或播放音頻設備時，彈奏鍵盤。 

 
 
 
 
 
 
 
 
 
 
 
 
 

麥克風 

立體聲音頻設備(CD 播放器等) 
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進行全局系統設置 
可以在工具畫面設置各個參數。特別是可以通過觸摸[Settings]選項分頁設置應用到本樂器整個系統的參數。一旦按下
[EXIT]按鈕返回原始畫面，即會啟動在工具畫面所做的更改。本章節說明與整個系統設置相關的一些功能。 
 

設置自動啟動任務 
可以決定打開電源時自動調出哪個畫面：現場設置畫面
或演奏組播放畫面。 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [System]選項分頁。 

2 在[Power on Mode]中，選擇 “Live Set” (現場

設置畫面)和分頁編號或 “Perform” (演奏組

播放畫面)作為啟動畫面。 

 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

 
 

設置按鈕指示燈 
可以控制按鈕指示燈變暗。 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [System]選項分頁。 

2 將 “Half Glow” 設置為 “Off”、“1/4” 或 “1/2”。 
選擇 “Off” 時，變暗功能關閉。 
選擇 “1/4” 時，微弱點亮狀態下的按鈕亮度降低為完
全點亮狀態的 25%。此亮度水平適合舞台等黑暗環
境。 
選擇 “1/2” 時，微弱點亮狀態下的按鈕亮度降低為完
全點亮狀態的 50%。此亮度水平適合難以分辨按鈕
狀態(微弱點亮或熄滅)的明亮環境(如室外)。 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

打開/關閉各種功能 
可以通過觸摸工具畫面上的[System]選項分頁設置各種
功能。 

打開/關閉動畫 

可以如下打開/關閉螢幕的動畫狀態。 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [System]選項卡。 

2 在 “Animation” 中選擇 “ON” 或 “OFF” 打
開或關閉動畫。 

 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

 

打開/關閉畫面模糊效果 

選擇任一畫面時，之前選擇的畫面變模糊。可以如下打
開/關閉此功能。 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [System]選項分頁。 

2 將 “Blur” 設置為 “ON” 或 “OFF” 打開或關

閉模糊效果。 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 
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打開/關閉提示音 

可以如下打開/關閉提示音(確認操作、選單/參數選擇等)。 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [System]選項分頁。 

2 將 “Beep” 設置為 “ON” 或 “OFF” 打開或

關閉提示音。 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

 

打開/關閉超級旋鈕的閃爍 

在默認設置中，超級旋鈕以當前節拍閃爍。可以如下打
開/關閉閃爍狀態。 
當關閉時，超級旋鈕保持持續點亮。 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [System]選項分頁。 

2 在 “Knob Flash” 中選擇 “ON” 或 “OFF” 打
開或關閉閃爍。 

 

觸摸面板校正 

如果觸摸面板偶爾發生不響應或響應不穩定，可能需要
校正觸摸面板。 

1 按住 [UTILITY]按鈕並按下 [PART SELECT 
MUTE/SOLO]按鈕。 
顯示工具畫面，已選擇[Calibrate Touch Panel]。 

2 按下[ENTER]按鈕。 

3 白色方格出現。觸摸方格校正觸摸面板，並繼

續觸摸後續白色方格直至操作完成。 

註 
或者，可以觸摸[UTILITY] → [Settings] → [System]
調出系統設置畫面並觸摸[Calibrate Touch Panel]。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

更改主調音 
可以調節 MODX 的調音。進行合奏時此功能很有用，可
以配合其他無法輕易調音的樂器(如鋼琴)的音高。 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [Sound]選項分頁。 

 

2 選擇 “Tune” 並使用數據輪更改參數。 
在此示例中，我們將值從 “440 Hz” 更改為 “442 
Hz”。由於調音參數以音分(1 音分=半音的 1/100)為
單位進行調節，右側顯示以赫茲為單位的對應值。轉
動數據輪將值更改為 “+8.0”。根據需要使用調諧器進
行更加精確的調音。 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

 

調音 
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更改力度曲線 
這五個曲線確定根據如何根據鍵盤演奏實際強度來產生
及傳送力度。畫面中顯示的圖形表示力度響應曲線。 
(橫線表示接收到的力度值(彈奏力度)；豎號表示傳送到
內部/外部音源的實際力度值。) 

1 按下[UTILITY]按鈕調出工具畫面，然後觸摸

[Settings]選項分頁 → [Sound]選項分頁。 

 

2 從畫面左側的彈出選單中選擇  “Velocity 
Curve” 並根據需要更改曲線設置。 

 
Normal 此線性 “曲線” 產生鍵盤演奏力度和實

際聲音改變間一到一的對應關係。 
Soft 此曲線產生增強的響應，特別是對於較

輕的力度。 
Hard 此曲線產生增強的響應，特別是對於較

高的力度。 
Wide 該曲線可增強彈奏力度，使得較柔和的

彈奏產生較低的力度，而較強力的彈奏
相應產生較高的力度。因此，可以使用
此設置擴大動態範圍。 

Fixed 此設置不論彈奏力度如何，均產生相同
量的聲音變化(在下述 Fixed Velocity 中
設置)。 

 

當力度曲線的參數設置為 “Fixed” 時 
彈奏音符的力度固定為此處的設置值。 

 

 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

 

設置本地控制打開/關閉 
本地控制通常設置為打開；但是在某些情況下(與電腦
和音序器程序配合使用時)，可能要將其關閉，使鍵盤
不彈奏內建聲部，但在鍵盤上彈奏音符時，仍通過
MIDI OUT 端口傳送適當的 MIDI 信息。 
此外，在本樂器中恰當處理輸入的 MIDI 信息。 

1 按下[UTILITY]按鈕調出工具畫面並觸摸螢

幕左側的 [Settings]選項分頁  →  [MIDI 
I/O]選項分頁。 

2 將 “Local Control” 設為 “ON” 或 
“OFF”。 

3 按下[EXIT]按鈕。 
儲存設置並返回前一畫面。 

 
 
 
 
 
 
 
 

力度曲線 

設置固定力度值

本機控制
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連接外接 MIDI 樂器 
通過標準 MIDI 電纜(市售)，可以連接外接 MIDI 樂器並由 MODX 控制。同樣，也可以使用外接 MIDI 設備(如鍵盤或音
序器)控制 MODX 的聲音。以下所示為幾個不同 MIDI 連接示例，請使用與想要的設置最類似的一個。 

註 
可使用內建接口、MIDI 端口或[USB TO HOST]端口進行 MIDI 數據的發送/接收；但是，無法同時使用。按下[UTILITY]
按鈕 → [Settings]選項分頁 → [MIDI I/O]選項分頁選擇要用於 MIDI 數據傳輸的端口。當使用本章節的說明時，請將 
“MIDI IN/OUT” 設置為 “MIDI”，此處將 MIDI 作為連接示例。 
 

從外接MIDI鍵盤或合成器控制MODX 
使用外接鍵盤或合成器遠程選擇和彈奏 MODX 的演奏
組。 

 

MIDI發送和接收通道 
務必使外接 MIDI 樂器的 MIDI 發送通道與 MODX 的
MIDI 接收通道相匹配。關於設置外接 MIDI 樂器的
MIDI 發送通道的詳細信息，請參見樂器的使用說明。
當 MIDI I/O 模式設置為 “多個” 時，MODX 各 MIDI
接收通道編號對應單個聲部編號，如通道 1 對應聲部
1，通道 2 對應聲部 2 等。當 MIDI I/O 設置為 “單個” 
時，單個通道用於接收所有聲部。 

 
 
 

由 MODX 控制外接 MIDI 鍵盤或合成器 

此連接可以通過彈奏 MODX 或播放來自 MODX 的樂
曲，使外接 MIDI 音源(合成器、音源模組等)發聲。當想
要使其它樂器與 MODX 一起發聲時，使用此連接。 
 
 
 
 
 
 
 
 
 

 

通過 MIDI通道分割 MODX和外接音源之間的聲音 
使用上述連接示例，可以彈奏兩種樂器並使其分別發
出不同聲部的聲音——例如，當樂曲播放 MODX 的
聲音時，鍵盤演奏發出外接樂器的聲音。若要使用此
功能，必須將 MODX 的發送通道和外接音源的接收
通道設置為相同的通道編號。MODX 各 MIDI 發送通
道編號對應各聲部編號，如通道 1 對應聲部 1，或通
道 2 對應聲部 2。但是，可以通過以下步驟選擇所需
發送通道。 
按下[UTILITY] → [Settings] → [Advanced]，然後
將 “Zone Master” 設置為 “ON”。若要編輯聲部，觸
摸[Part Settings] → [Zone Settings]調出區域設置
畫面。確認 “Zone Transmit” 中的 MIDI 發送通道，
如有必要，請更改此參數。當只想讓外接音源發聲
時，請調低 MODX 的主音量或通過以下操作將 
“Local Control” 設 置 為  “off” ： [UTILITY] → 
[Settings] → [MIDI I/O]調出 MIDI 設置畫面，然後將 
“Local Control” 設置為  “off”。關於如何設置外接
MIDI 樂器的 MIDI 接收通道的信息，請參見 MIDI 樂
器的使用說明書。 

 

外接 MIDI 鍵盤、合成器等 

MOTIF-RACK XS 等外接 MIDI 音源
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使用連接的電腦 
將 MODX 連接到電腦，可以使用電腦上的 DAW 或音序軟件製作原創樂曲。 

註 
縮寫 DAW (數位音樂工作站)指的是用於錄音、編輯和混合音頻及 MIDI 數據的音樂軟件。主要的 DAW 應用程序為
Steinberg Cubase、Logic、Ableton Live 和 ProTools。 
 

連接電腦 
將 MODX 連接到電腦時，需要使用 USB 線纜和 Yamaha 
Steinberg USB Driver。按照下列說明進行操作。請註
意，通過 USB 線纜可傳送音頻數據和 MIDI 數據。 

1 請從我們的網站下載最新 Yamaha Steinberg 
USB Driver。 
按一下 Download 按鈕之後，對壓縮文件進行解壓
縮。 

 
https://download.yamaha.com/ 

 
進入 Support 網頁(或點擊 “Firmware/Software” )
後，輸入相應的型號名稱。 

註 
 從以上網站上也可找到系統要求的相關信息。 
 Yamaha Steinberg USB Driver 可能會修訂及更

新，恕不另行通知。請務必在上述網站查看和下載
最新版本。 

2 將 Yamaha Steinberg USB Driver 安裝到電

腦。 
有關安裝的說明，請參見下載的文件包中附帶的在線
安裝指南。將本樂器連接到電腦時，如下所示將 USB
線纜連接到本樂器的[USB TO HOST]端口和電腦的
USB 端口。 

 

3 按下[UTILITY]按鈕調出工具畫面。 

4 觸摸畫面左側的[Settings]選項分頁 → [MIDI 
I/O]選項分頁。 

 
 
 
 
 
 

5  將 “MIDI IN/OUT” 設置為 “USB”。 
務必啟用本樂器的[USB TO HOST]端口。 

 

6 根據個人偏好進行音頻數據的輸入和輸出設

置。 
可以從[UTILITY] → [Settings] → [Audio I/O]更改
設置。 
使用快速設置功能更改音頻和 MIDI 數據相關參數，
調出專用編程的預置即可對電腦/音序器相關的不同
應用程序快速配置 MODX。 
要執行該操作，觸摸畫面左側的[Settings]選項分頁 
→ [Quick Setup]選項分頁調出快速設置畫面。 
觸摸[Store Current Settings]可以將所需設置儲存到
任意 1 至 3 快速設置。 

註 
有關快速設置功能可設置的參數的詳細信息，請參見
參考說明書的 PDF 文件。 

 

 

[USB TO HOST]端口
USB 端口 

USB 線纜 

後面板

快速設置 1 至 3 
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使用[USB TO HOST]端口時的註意事項 
將電腦連接至[USB TO HOST]端口時，務必遵循以下
要點，從而避免電腦當機和數據損壞或丟失。 

須知 
 請使用 AB 型 USB 連接線。請勿使用 USB 3.0

連接線。 
 在打開/關閉樂器電源或者插入/拔下[USB TO 

HOST]端口的 USB 線纜之前執行下列操作。 
- 關閉電腦上任何打開的應用軟件。 
- 確保本樂器沒有數據傳輸出來。(只有彈奏鍵

盤或播放樂曲時才有數據傳送。) 
 當電腦與本樂器相連時，執行下列操作應至少等

待 6 秒鐘：(1)關閉本樂器電源然後再次打開時，

或者(2)交替連接/斷開 USB 線纜時。 
 
如果電腦或樂器當機，重新啟動應用程序軟件或電腦
系統，或者關閉樂器電源再打開。 

 
 

MIDI通道和 MIDI端口 
MIDI 數據被分配給 16 個通道中的一個，此合成器能
通過 16 個 MIDI 通道同時演奏 16 個獨立聲部。不過，
16 通道限制也可以通過單獨的 MIDI “端口” 來解決，
每個 MIDI 端口支持 16 個通道。一根 MIDI 線纜的標
準為可以最多同時使用 16 通道處理數據，而 USB 連
接可以處理更多的數據——有賴於 MIDI 端口的使
用。每個 MIDI 端口可以調用 16 個通道，USB 連接
最多允許 8 個端口的使用，結果是：可以在電腦上使
用最多 128 個通道(8 個端口 x 16 個通道)。 
使用 USB 線纜將本樂器連接到電腦時，MIDI 端口的
定義如下： 
 
端口 1 
本樂器上的音源模組只能識別和使用此端口。當將
MODX 用作外接 MIDI 樂器或電腦的音源彈奏時，應
在相連的 MIDI 設備或電腦上將 MIDI 端口設置為 1。
 
端口 3 
此端口用作 MIDI Thru 端口。通過[USB TO HOST]
端口在端口 3 接收到的 MIDI 數據將通過 MIDI [OUT]
端口再次傳送到外接 MIDI 設備。 
 
通過 MIDI [IN]端口在端口 3 接收到的 MIDI 數據將通
過[USB TO HOST]端口再次傳送到外接設備(電腦
等)。使用 USB 連接時，務必要匹配 MIDI 發送端口
和 MIDI 接收端口，以及匹配 MIDI 發送通道和 MIDI
接收通道。請務必根據上述信息設置與本樂器相連的
外接設備的 MIDI 端口。 

 
 
 
 
 
 
 
 
 
 

 

音頻通道 
MODX 的音頻信號可輸出到[USB TO HOST]端口和
OUTPUT [L/MONO]/[R]插孔。 
在連接電腦時，使用[USB TO HOST]端口。在此情況
下，最多可使用 10 個音頻通道(5 個立體聲通道)。如
下進行輸出至通道分配：[EDIT] → [Part Settings] 
→ [General]畫面中的 “Part Output”。 
 
MODX 的音頻信號可從[USB TO HOST]端口和 A/D 
INPUT [L/MONO]/[R]插孔輸入。 
最多可將 4 個通道(2 個立體聲通道)的音頻輸入到
[USB TO HOST]端口。在混音畫面或演奏組編輯畫面
中設置輸出電平。信號輸出到 OUTPUT [L/MONO]/ 
[R]插孔(2 個通道)。此外，最多 2 個音頻通道(1 個立
體聲通道)可輸入到 A/D INPUT [L/MONO]/[R]插孔。
信號發送到 MODX 的 A/D 輸入部分。有關更多詳細
說明，請參見參考說明書的 PDF 文件。 
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使用電腦製作樂曲 
通過將 MODX 與 MODX 連接的電腦上的 DAW 軟件組合
使用，您可充分利用以下功能及應用。 
 
 將 MODX 演奏的 MIDI 錄音和音頻錄音錄製到 DAW

軟件。 
 使用 MODX 音源從 DAW 軟件播放樂曲。 
 
本章節中概述了在連接完成(第 55 頁)後將電腦上的
DAW 軟件與 MODX 組合使用的方法。 
 

將 MODX 上的演奏作為 MIDI 數據錄製到電

腦(不錄製琶音播放) 

通過此方法，可將 MODX 上的演奏僅作為 MIDI 數據錄
製到 DAW 中。請切記，無法錄製琶音播放。 

設置 MODX 

1 按下[UTILITY]按鈕調出工具畫面。 

2 觸摸畫面左側的 [Settings] 選項分頁  → 
[Quick Setup]選項分頁調出快速設置畫面。 

3 選擇  “Quick Setup” 的  “1 (MIDI Rec on 
DAW)”。 

 

4 按下[EXIT]按鈕選擇想要錄製的演奏組。 
 

設置 DAW 軟體 

1 在 DAW 軟件上將 MIDI Thru 設置為 “on”。 
通過將 MIDI Thru 設置為 “on”，彈奏鍵盤所產生的
並發送到電腦的 MIDI 數據將返回到 MODX。如下示
例所示，根據錄製音軌的設置，從 MODX 發送然後
通過 MIDI 通道 1 錄製到電腦的 MIDI 數據將通過
MIDI 通道 3 從電腦返回到 MODX。因此，MODX 的
音源將使彈奏鍵盤產生的 MIDI 數據發出如同通道 3
中的 MIDI 數據一樣的聲音。 

 

2 將 MODX 演奏錄製到 DAW 軟體中。 
 

將 MODX 上的演奏作為 MIDI 數據錄製到電

腦(錄製琶音播放) 

通過此方法，可將 MODX 上的琶音播放作為 MIDI 數據
錄製到 DAW 中。 
 

設置 MODX 

1 按下[UTILITY]按鈕調出工具畫面。 

2 觸摸畫面左側的 [Settings] 選項分頁  → 
[Quick Setup]選項分頁調出快速設置畫面。 

3 選擇  “Quick Setup” 的  “2 (Arp Rec on 
DAW)”。 

 

4 按下[EXIT]按鈕選擇想要錄製的演奏組。 
 

設置 DAW 軟體 
遵照 “將 MODX 上的演奏作為 MIDI 數據錄製到電腦(不
錄製琶音播放)” 中的相同操作。 
 
 
 
 
 

電腦
(Cubase 等) 

[USB TO HOST]端口 

音源模組 
(識別 MIDI 通道

3 中的數據)

鍵盤 
(通過 MIDI

通道 1 輸出)
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將 MODX 用作音源從電腦播放樂曲 

以下說明為如何將本樂器用作 MIDI 音源的方法。在這種
情況下，從電腦上的 DAW 軟件發送實際的 MIDI 音序數
據，讓您充分利用 MODX 的動感聲音，另一優點是不使
用軟件合成器從而節省電腦的處理功耗。 

設置 MODX 

1 選擇要編輯的演奏組。 

2 觸摸演奏組播放畫面上的[Mixing]選項分頁調

出混音畫面。 

3 根據需要設置 1–16 聲部的混音。 
 

設置 DAW 軟體 

1 將用於彈奏 MODX 的音軌的 MIDI 輸出端口

設置為 MODX 的端口 1。 

2 將 MIDI 數據登錄到電腦上 DAW 軟件的各音

軌。 
MIDI 音軌對應部分的音源設置將在 MODX 的混音畫
面上進行。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

MODX 使用說明書 59 

備忘錄 
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儲存/加載數據 
工具畫面中提供了在 MODX 和連接至[USB TO DEVICE]端口的 USB 隨身硬碟之間傳送整個系統設置和數據(如演奏
組和現場設置)的工具。 
本章節說明如何將本樂器用戶儲存器中的所有數據作為 “User” 文件儲存/加載。 
 

儲存設置到 USB 隨身硬碟 

1 將 USB 隨身硬碟連接到本樂器的[USB TO 
DEVICE]端口。 

2 按下[UTILITY]按鈕調出工具畫面，然後觸摸

畫 面 左 側 的 [Contents] 選 項 分 頁  → 
[Store/Save]選項分頁。 

3 將 “Content Type” 設置為 “User File”。 

 

4 選擇所需 USB 隨身硬碟目錄。 

 

 父文件夾 

 USB 隨身硬碟中的儲存目的地文件夾 

 新儲存目的地 

 現有文件 

5 觸摸[Save As New File]中的 “+”。 

註 
若要覆蓋現有文件，觸摸文件名。 

 
 
 
 

6  顯示文本輸入畫面。輸入要儲存的文件名。 
有關輸入名稱的詳細說明，請參見 “基本操作和顯示
畫面” 中的 “命名(輸入字符)” (第 21 頁)。 

7 觸摸文本輸入畫面上的[Done]以實際執行儲

存操作。 

註 
若 要 覆 蓋 現 有 文 件 ， 在 提 示 確 認 的 畫 面 上 選 擇 
“YES”。 

 
 

從 USB 隨身硬碟加載設置 

須知 
加載操作將覆蓋本樂器中已存在的數據。重要數據務必

儲存在連接到[USB TO DEVICE]端口的 USB 隨身硬碟。 

1 將 USB 隨身硬碟連接到本樂器的[USB TO 
DEVICE]端口。 

2 按下[UTILITY]按鈕調出工具畫面，然後觸摸

畫面左側的[Contents]選項分頁 → [Load]選
項分頁。 

3 將 “Content Type” 設置為 “User File”。 

4 選擇所需 USB 隨身硬碟文件夾。 

5 選擇要執行加載操作的儲存器文件 (副檔

名：.X8U)。 

 

 源 USB 隨身硬碟 

 USB 隨身硬碟中的源文件夾 

 現有文件 

 

選擇內容類型 
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使用[USB TO DEVICE]端口時的註意

事項 
本樂器內建[USB TO DEVICE]端口。當連接 USB 設備到
該端口時，一定要小心操作 USB 設備。使用時請遵循下
述重要註意事項。 

註 
有關使用 USB 設備的詳細信息，請參見 USB 設備的使
用說明書。 

兼容的 USB 設備 
 
 USB 隨身硬碟 
 
USB 集線器、電腦鍵盤、滑鼠等其它 USB 設備無法使用。 
本樂器未必支持所有的商用 USB 設備。Yamaha 並不保
證能夠兼容您所購買的 USB 設備。在購買用於本樂器的
USB 設備前，請訪問下面的網站： 
 
https://download.yamaha.com/ 
 
進入 Support 網頁(或點擊 “Documents and Data” )後，
輸入相應的型號名稱。 
 
儘管 USB 設備 1.1 到 3.0 版本均可在本樂器上使用，但
數據從 USB 加載或儲存到 USB 的時間長度取決於數據
類型或樂器狀態。 

須知 
USB TO DEVICE 端口的額定值為 5V/500mA 以下。請

勿連接高於額定值的 USB 設備，否則可能造成本樂器的

損壞。 
 

連接 USB 設備 
將 USB 設備連接到[USB TO DEVICE]端口時，確保設備
上的接口適用且連接方向正確。 

須知 
 請勿在播放/錄製、文件管理(如儲存、複製、刪除和

格式化操作)或訪問 USB 設備的過程中，斷開或連接

USB 設備。否則可能造成樂器操作的 “當機” 或 USB
設備和數據的操作中斷。 

 連接然後斷開 USB 設備時(反之亦然)，確保 2 個操

作之間相隔幾秒鐘。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

使用 USB 隨身硬碟 
將本樂器連接到 USB 隨身硬碟後，您可以將創建的數據
儲存到相連的設備上，也可以從相連設備讀取數據。 

可使用的 USB 隨身硬碟的最大數量 
[USB TO DEVICE]端口上只能連接一個 USB 隨身硬碟。 

格式化 USB 隨身硬碟 
您只能用本樂器格式化 USB 隨身硬碟(第 61 頁)。在其它
設備上格式化 USB 隨身硬碟可能無法正確操作。 

須知 
格式化操作將覆蓋以前已有的數據。確保要格式化的

USB 隨身硬碟不含重要數據！ 

註 
有關如何格式化 USB 隨身硬碟的詳細說明，請參見參考
說明書的 PDF 文件。 

保護數據(寫保護) 
為防止誤刪除重要的數據，請使用每個 USB 隨身硬碟的
寫保護功能。當向 USB 隨身硬碟儲存數據的時候，確定
已禁用了寫保護功能。 

關閉本樂器 
關閉本樂器時，確保樂器沒有通過播放/錄製、文件管理
(如儲存、複製、刪除和格式化操作)等操作訪問 USB 隨
身硬碟。否則可能造成 USB 隨身硬碟出錯和數據中斷。 
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SHIFT 功能列表 
本樂器上的某些重要功能和操作可通過便捷的面板控制快捷方式執行。 
只需在按住[SHIFT]按鈕的同時按下所示按鈕(如下)即可。 
 

操作 功能 

[SHIFT] + KNOB POSITION [1] 在值 1 中儲存分配到旋鈕的分配 1–8。 

[SHIFT] + KNOB POSITION [2] 在值 2 中儲存分配到旋鈕的分配 1–8。 

[SHIFT] + OCTAVE [-] 將移調值減 1。 

[SHIFT] + OCTAVE [+] 將移調值加 1。 

[SHIFT] + OCTAVE [-] + OCTAVE [+] 將移調值復位至 0。 

[SHIFT] + [DEC/NO] 將所選參數值減 10。 
在現場設置畫面中，該操作將調出上一頁。 

[SHIFT] + [INC/YES] 將所選參數值加 10。 
在現場設置畫面中，該操作將調出下一頁。 

[SHIFT] + [ENTER] 調出速度設置畫面。 

[SHIFT] + [PERFORMANCE (HOME)] 調出概覽畫面。 

[SHIFT] + [LIVE SET] 調出現場設置註冊畫面。 

[SHIFT] + [UTILITY] 調出快速設置畫面。 

[SHIFT] + [CATEGORY] 調出當前所選聲部的聲部分類查找畫面。 

[SHIFT] + 滑桿選擇[1–4] [5–8] 當 滑 桿 功 能 [PART]/[ELEMENT/OPERATOR] 按 鈕 設 置 為  “PART” 
時，選擇聲部 9 或聲部 13。 

[SHIFT] + [EDIT] 打開複製/交換對話方塊。 

[SHIFT] + SCENE [1]–[8] 將 SCENE 1–8 儲存至 SCENE [1]–[8]按鈕。 

[UTILITY] + [PART SELECT MUTE/SOLO] 調出觸摸面板校正設置畫面。 
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畫面訊息 
 

LCD指示 說明 

** will be deleted. 要執行的指定操作將會導致指定數據被刪除時，顯示此信息。 

** will be overwritten. 當已存在與想要儲存的文件/文件夾同名的文件/文件夾時，顯示此信
息。 

Activate the source controller to assign. 可以將參數分配到要啟動的控制器。 

Advanced settings will be initialized. 將初始化[Advanced]選項分頁中執行的所有設置。 

All data and libraries will be initialized. 
Unsaved user data will be lost. 

將初始化所有數據和群組。未儲存的用戶數據將丟失。 

All data is initialized upon power-on. 電源打開時初始化所有數據。 

All settings will be initialized. User data is 
kept. 

將初始化所有設置。用戶數據保留。 

All sound will be stopped during 
optimization. 

在恢復內存之前，顯示此信息。優化期間，所有聲音將停止。 

All user data will be initialized. Unsaved 
user data will be lost. 

將初始化所有用戶數據。未儲存的用戶數據將丟失。 

Are you sure? 確定是否要執行指定操作。 

Arpeggio full. 當不再有琶音聲部開關用於打開時顯示。 

Assignable Knob Full. 當所有可分配旋鈕處於使用中，且不再有超級旋鈕設置可被添加時顯
示。 

Audio Rec stopped due to lack of memory 
space. 

USB 隨身硬碟已滿，不可再儲存音頻錄音數據。使用新的 USB 隨身
硬碟，或者從 USB 隨身硬碟中刪除不必要的數據以獲取儲存空間。

Auto power off disabled. 禁用自動關機之前，顯示此信息。 

Bulk data protected. 由於設置無法接收批量數據。 

Can’t process. MODX 無法處理的請求操作。 

Completed. 已經完成指定的加載、儲存、格式化或其它作業。 

Connecting to USB device... 當前正在識別與[USB TO DEVICE]端口相連的 USB 隨身硬碟。 

Control Assign Full. 所有控制分配處於使用中。 

Copy protected. 試圖導出或儲存受複製保護的數位音頻源。 

Current user data will be overwritten by **. 正在儲存文件時顯示此信息，該名稱下的用戶數據已存在。 

Data memory full. 內存已滿，防止將錄製的數據儲存於群組中。 

Device number is off. 由於設備編號空缺，導致無法傳送/接收批量轉儲數據。 

Device number mismatch. 因為設備編號不匹配，無法傳送/接收批量轉儲數據。 

File is not found. 加載操作期間未找到指定文件。 

File or folder already exists. 已存在與想要儲存的文件/文件夾同名的文件/文件夾。 

File or folder path is too long. 由於已超過指示路徑的最大字符數，嘗試訪問的文件或文件夾無法訪
問。 

Folder is not empty. 嘗試刪除包含數據的文件夾。 

Illegal bulk data. 接收批量轉儲數據或批量請求信息時發生錯誤。 

Illegal file name. 指定文件名稱無效。請嘗試輸入不同的名稱。 

Illegal file. 本合成器無法使用或無法加載指定文件。 

Keybank full. 執行加載操作時，已超過鍵群組的最大總數。 

Library full. 執行相關操作時，已超過群組的最大總數。 
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LCD指示 說明 

MIDI buffer full. 由於一次接收的數據過多導致處理 MIDI 數據失敗。 

MIDI checksum error. 接收批量轉儲數據時發生錯誤。 

Modified: Common AsgnKnob? 用於聲部編輯的控制分配畫面中，當添加或編輯與超級旋鈕相關的可
分配旋鈕的設置時，用於通用/音頻編輯的控制分配設置被自動添加
或編輯時顯示。 

No data. 當所選音軌或範圍不包含數據時，顯示此信息。請選擇適當音軌或範
圍。 

No read/write authority to the file. 表示無權讀取/寫入文件。 

Now initializing all data… 表示本合成器正在恢復出廠編程設置。 

Now initializing… 表示正在初始化指定數據。 

Now loading... 表示正在加載文件。 

Now receiving MIDI bulk data... 表示本合成器正在接收 MIDI 批量轉儲數據。 

Now saving... 表示正在儲存文件。 

Now transmitting MIDI bulk data... 表示本合成器正在發送 MIDI 批量轉儲數據。 

Part Full. 所有聲部處於使用中。 

Please connect USB device. 將 USB 設備連接到[USB TO DEVICE]端口進行音頻錄音。 

Please keep power on. 正在將數據寫入閃存 ROM。在數據寫入到閃存 ROM 中時絕不要嘗
試關閉電源。在顯示此信息時關閉電源，將導致所有用戶數據丟失，
並且有可能引起系統當機(因為閃存 ROM 中的數據損毀)。這樣也可
能會導致在下次打開電源時，MODX 無法正確啟動。 

Please reboot to enable the new Audio I/O 
Mode. 

請重新啟動本合成器以啟用音頻數據輸入/輸出設置的更改。 

Please reboot to maintain internal memory. 請重新啟動本合成器恢復內存。 

Please stop audio play/rec. 試圖進行的操作無法在音頻錄音或播放過程中執行。 

Please stop sequencer. 試圖進行的操作無法在樂曲播放過程中執行。 

Please wait… 表示本合成器正在執行指定操作。 

Recall latest edits. 如果您在編輯一個演奏組，且在沒有儲存編輯的情況下選擇另一個演
奏組，將會擦除所做的所有編輯。此時，可使用調用將演奏組恢復為
最新編輯的狀態。 

Redo last recording. 確認是否要恢復已撤銷的操作。 

Sample is protected. 無法覆蓋樣本數據。 

Sample is too long. 樣本數據過大且無法執行加載操作。 

Sample memory full. 樣本儲存器已滿且無法進一步執行加載操作。 

Scene stored. 場景已儲存到[SCENE]按鈕之一。 

Song data overload. 樂曲數據過大無法播放。 

Song full. 執行相關操作時，已超過樂曲的最大總數。 

Touch the white square. 在觸摸面板校正期間當需要觸摸顯示的白色矩形時，顯示此信息。 

Turn on Memory Switch to memorize ** 
into this scene. 

當對某功能打開[Memory] (記憶開關)時，對應功能信息自動儲存在當
前所選的[SCENE]按鈕中。 

Undo last recording. 確認是否要撤銷最近的錄製。 

Unsupported USB device. 當連接不支持的 USB 設備時，顯示此信息。 

USB connection terminated. 由於電流異常，與 USB 隨身硬碟的連接發生中斷。從[USB TO 
DEVICE]端口斷開 USB 隨身硬碟，然後按下任一面板按鈕。 
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LCD指示 說明 

USB device is full. USB 隨身硬碟已滿，不可再儲存數據。使用新的 USB 隨身硬碟，或
者從儲存設備中刪除不必要的數據以獲取儲存空間。 

USB device is write-protected. 當嘗試寫入受保護的 USB 隨身硬碟時，顯示此信息。 

USB device read/write error. 對 USB 隨身硬碟讀取或寫入時發生錯誤。 

USB device will be formatted. 在格式化 USB 設備之前，顯示此信息。 

Waveform full. 執行相關操作時，已超過波形的最大總數。 
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故障排除 
沒有聲音？聲音失常？當出現類似此類的問題時，請先查看下列要點，再確定本產品是否出現故障。在將您的數據備
份到 USB 隨身硬碟(第 19 頁)後執行數據初始化(第 60 頁)可解決 很多問題。如果問題依然存在，請諮詢您所在地的
Yamaha 經銷商。 

觸摸面板無法正確響應。 

■ 您在觸摸面板上觸摸點是否與下方畫面中目標項目正確對齊？ 
校正觸摸面板。 

 [UTILITY] + [PART SELECT MUTE/SOLO] → [ENTER]   

 [UTILITY] → [Settings] → [System] → [Calibrate Touch Panel]   

沒有聲音。 

■ 是否所有滑桿均設置到適合音量(0 或最小值除外)？ 

■ MODX 是否通過音頻線正確連接到相關外接設備(如擴大機、喇叭、耳機)？ 
由於 MODX 沒有內建喇叭，因此需要外接音頻系統或一副立體聲耳機才可正確監聽(第 18 頁)。 

■ 是否已開啟本合成器和連接的外接設備的電源？ 

■ 是否已進行了所有適當音量的設置——包括本合成器上主音量和任何已連接外接設備上的音量？ 
當踏板控制器與[FOOT CONTROLLER]插孔相連時，踩下踏板控制器。 

■ 是否將本地控制參數設置為關閉？ 
當本地控制參數設置為關閉時，即使彈奏鍵盤，也不會發出聲音。 

 [UTILITY] → [Settings] → [MIDI I/O] → “Local Control”   

■ 是否選擇了空白聲部？ 
如果是，將任意聲音分配到該聲部或選擇其他聲部。 

■ 是否打開了各聲部的靜音開關？ 
當靜音開關打開時，即使彈奏鍵盤，也不會發出聲音。 

 [PERFORMANCE (HOME)] → 聲部 “Mute”   

 [PART SELECT MUTE/SOLO] → “Mute” → 聲部選擇   

■ 是否關閉了各聲部的鍵盤控制？ 

 [PERFORMANCE (HOME)] → 聲部 “Kbd Ctrl”   

■ 是否打開了各聲部的 “Arp Play Only” 參數？ 
當此參數打開時，對應聲部僅通過琶音播放發出聲音。 

 [PERFORMANCE (HOME)] → 聲部選擇 → [EDIT] → [Part Settings] → [General] → “Arp Play Only”   

 [PERFORMANCE (HOME)] → 聲部選擇 → [EDIT] → [Arpeggio] → [Common] → “Arp Play Only”   

■ 使用外接控制器時，MIDI 音量或 MIDI 表情設置是否過低？ 

■ 效果與濾波器設置是否合適？ 
如果使用濾波器，試著改變截止頻率。某些截止設置有可能會過濾掉所有聲音。 

 [PERFORMANCE (HOME)] → [EDIT] → [Effect]   

 [PERFORMANCE (HOME)] → 聲部選擇 → [EDIT] → [Effect]   

 標準聲部(AWM2)和鼓聲部時 

 [PERFORMANCE (HOME)] → 聲部選擇 → [EDIT] → 元素/鍵選擇 → [Filter]   

 標準聲部(FM-X)時 

 [PERFORMANCE (HOME)] → 聲部選擇 → [EDIT] → Operator selection → [Pitch/Filter]   

■ 是否選擇了 “Vocoder” 作為聲部的插入效果類型？ 
如果是，將與 A/D INPUT [L/MONO]/[R]插孔相關的參數設置為合適的值，然後在將聲音輸入到 MODX 已連接的
麥克風的同時彈奏鍵盤。確認後面板上的 A/D INPUT [GAIN]旋鈕是否設置到最小位置。 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect] → [Routing]   
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■ 音量或表情設置是否過低？ 

 [UTILITY] → [Settings] → [Sound] → 音源 “Volume”   

 [EDIT] → [General] → “Volume”   

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [General] → “Volume”   

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [General] → “Dry Level”   

 標準聲部(AWM2)和鼓聲部時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器 → [Amplitude] → [Level/Pan] → “Level”   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 操作器選擇 → [Level] → “Level”   

■ 元素開關、音高限制、力度限制和力度偏移值等參數設置是否合適？ 

 標準聲部(AWM2)和鼓聲部時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [General]   

 [EDIT] → 聲部選擇 → 元素/鍵選擇 → [Osc/Tune]   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [General]   

■ 是否打開了聲部各元素/操作器的靜音開關？ 

 [EDIT] → 聲部選擇 → 操作器的靜音開關   

■ 如果是標準聲部(FM-X)，載波電平是否設置為 “0”？ 

 [EDIT] → 聲部選擇 → 操作器選擇 → [Level] → “Level”   

■ 是否關閉了各聲部的輸出參數？ 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [General] → “Part Output”   

A/D INPUT 插孔無聲音輸出。 

■ 是否打開了麥克風的開關？ 

■ 確認麥克風類型。務必使用動圈式麥克風。 

■ 麥克風或音頻設備和本樂器之間的線纜是否正確連接？ 

■ A/D INPUT [GAIN]旋鈕是否轉到最小？ 

■ A/D INPUT [ON/OFF]按鈕是否打開？ 

■ 確認 A/D INPUT [L/MONO]/[R]的連接狀態是否符合 “Mono/Stereo” 參數。 

 [EDIT] → [Audio In] → [Mixing] → A/D In “Input Mode”   

■ 確認 “Mic/Line” 參數是否設置為適當的值。 
當相連設備(如麥克風)的輸出電平較低時，將此參數設置為 “Mic”。當相連設備(如合成器鍵盤、CD 播放機)的輸出
電平較高時，將此參數設置為 “Line”。 

 [UTILITY] → [Settings] → [Audio I/O] → “A/D Input”   

■ A/D 輸入聲部的音量設置是否太低？ 

 [EDIT] → [Audio In] → [Mixing] → A/D In “Volume”   

■ 效果設置是否合適？ 

 [EDIT] → [Audio In] → [Routing]   

■ A/D 輸入聲部的輸出設置是否正確？ 

 [UTILITY] → [Settings] → [Audio I/O] → Output   

■ 確認是否選擇了 Vocoder 效果。 
當選擇 Vocoder 作為當前聲部的插入效果時，視參數設置而定，從 A/D INPUT [L/MONO]/[R]插孔輸入的音頻信號
可能不會發出聲音。 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect] → [Routing]   
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持續不停播放。 

■ 當[ARP ON/OFF]按鈕打開時，按下此按鈕使其熄滅。 

■ 在樂曲畫面中時，按下[ ] (停止)按鈕。? 

■ 當繼續發出延遲等效果聲時，確認效果設置或重新選擇演奏組。 

■ 當繼續發出節拍聲時，確認以下參數設置。將此參數設置為 “always” 以外的設置，無論音序器狀態如何，此設置
均會始終播放節拍聲。 

 [UTILITY] → [Tempo Settings] → Click “Mode”   

聲音失真。 

■ 效果設置是否合適？ 
在某些設置下使用效果有可能會產生失真。 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect]   

■ 濾波器設置是否合適？ 
過高的濾波器共鳴設置可導致失真。 

 標準聲部(AWM2)和鼓聲部時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器 → [Filter]   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Pitch/Filter]   

■ 是否將下列任何音量參數設置過高以至於產生削波？ 

 [UTILITY] → [Settings] → [Sound] → 音源 “Volume”   

 [UTILITY] → [Settings] → [Audio I/O] → “Output”   

 [EDIT] → [General] → “Volume”   

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [General] → “Volume”   

 標準聲部(AWM2)和鼓聲部時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器 → [Amplitude] → [Level/Pan] → “Level”   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 操作器選擇 → [Level] → “Level”   

聲音被切除。 

■ 整個聲音(通過鍵盤播放和樂曲/聲部/琶音播放)是否超過 MODX 的最大複音數(AWM2 為 128，FM-X 為 60)？ 

每次只有一個音符發聲。 

■ 當發生此情況時，將當前模式中的 Mono/Poly 參數設置為 “mono”。 
若要演奏和絃，將此參數設置為 “poly”。 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [General] → “Mono/Poly”   

音高或音程錯誤。 

■ 各聲部的主調音參數是否設置為 “0” 以外的其它值？ 

 [UTILITY] → [Settings] → [Sound] → 音源 “Tune”   

■ 各聲部的音高切換參數是否設置為 “0” 以外的其它值？ 

 標準聲部(AWM2)和鼓聲部時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [Pitch] → “Note Shift”   

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [Pitch] → “Detune”   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Pitch/Filter] → [Pitch] → “Note Shift”   

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Pitch/Filter] → [Pitch] → “Detune”   
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■ 當聲部產生錯誤音高時，是否從微調參數中選擇了合適的調音系統？ 

 標準聲部(AWM2)時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Part Settings] → [Pitch] → “Micro Tuning Name”   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Pitch/Filter] → [Pitch] → “Micro Tuning Name”   

■ 當聲部產生錯誤音高時，LFO 音高調製深度是否設置過高？ 

 標準聲部(AWM2)時 

 [EDIT] → 聲部選擇 → 元素選擇 → [Element LFO] → “Pitch Mod”   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Mod/Control] → [2nd LFO] → “Pitch Modulation”   

■ 當聲部產生錯誤音高時，粗調和微調設置是否合適？ 

 標準聲部(AWM2)和鼓聲部時 

 [EDIT] → 聲部選擇 → 元素/鍵選擇 → [Osc/Tune] → “Coarse”   

 [EDIT] → 聲部選擇 → 元素/鍵選擇 → [Osc/Tune] → “Fine”   

 標準聲部(FM-X)時 

 [EDIT] → 聲部選擇 → 操作器選擇 → [Form/Freq] → “Coarse”   

 [EDIT] → 聲部選擇 → 操作器選擇 → [Form/Freq] → “Fine”   

■ 當聲部似乎產生錯誤音高時，控制器的目的地是否設置為 “Pitch”？ 

 [EDIT] → 聲部選擇 → [Mod/Control] → [Control Assign] → “Destination”   

無效果。 

■ 是否關閉了效果開關？ 

 [UTILITY] → [Effect Switch]   

■ 變奏發送或殘響發送是否設置為 “0” 以外的其它值？ 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect] → [Routing] → “Var Send”   

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect] → [Routing] → “Rev Send”   

■ 變奏返回或殘響返回是否設置為 “0” 以外的其它值？ 

 [EDIT] → [Effect] → [Routing] → “Var Return”   

 [EDIT] → [Effect] → [Routing] → “Rev Return”   

■ 是否所有元素/鍵的插入效果輸出參數均已設置為效果設置中的 “thru”？ 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect] → [Routing] → “Element 1–8”   

■ 系統效果情況下，是否任何或所有效果類型已設置為 “No Effect”？ 

■ 插入效果情況下，是否任何或所有效果類型已設置為 “Thru”？ 

■ 確認插入開關參數是否正確設置。 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect] → [Ins A]/[Ins B]   

■ 是否超過應用插入效果的聲部數量？ 
對於聲部 9–16，您可以將插入效果至多應用至四個聲部。 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Effect] → [Ins Assign]   

無法啟動琶音。 

■ 確認[ARP ON/OFF]按鈕為打開還是關閉。 

■ 計算琶音開關已打開的聲部數量。 
您最多可以同時播放八個聲部的琶音。 
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■ 音高限制和力度限制等琶音相關參數是否正確設置？ 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Arpeggio] → [Common]   

■ 琶音類型參數是否設置為 “off”？ 

 [EDIT] → 聲部選擇 → [Arpeggio] → [Individual] → “Name”   

■ 確認琶音開關參數。 
如果當前聲部的參數設置為關閉，即使[ARP ON/OFF]按鈕打開，也不會通過鍵盤演奏觸發琶音播放。 

 [PERFORMANCE (HOME)] → 聲部選擇 → “Arp On”   

■ [Arp Bypass]按鈕是否設置為 “on”？ 

 [UTILITY] → [Effect Switch]   

無法停止琶音。 

■ 當釋放琴鍵時如果琶音播放不停止，將 Arpeggio Hold 參數設置為 “off”。 

 [EDIT] → 聲部選擇 → 元素/鍵/操作器[Common] → [Arpeggio] → [Common] → “Hold”   

即使按下[ ] (播放)按鈕也無法開始播放樂曲。 

■ 所選的樂曲是否確實包含數據？ 

無法錄製樂曲。 

■ 是否有足夠的自由儲存空間用於錄製？ 
MODX 儲存器最多可以錄製 128 首樂曲。如果儲存器已滿，則無法錄製更多內容。 

電腦與 MODX 之間的數據通信不能正常工作。 

■ 確認電腦上的端口設置是否恰當。 

■ 確認 MIDI IN/OUT 參數是否已設置為恰當的值。 

 [UTILITY] → [Settings] → [MIDI I/O] → MIDI “MIDI IN/OUT”   

MIDI 批量轉儲數據傳送/接收不能正常工作。 

■ 接收批量轉儲參數是否設置為關閉？ 
將接收批量轉儲參數設置為打開。 

 [UTILITY] → [Settings] → [Advanced] → MIDI “Receive Bulk”   

■ 當接收通過批量轉儲功能傳送並且錄製在外接 MIDI 設備中的 MIDI 批量數據時，需要將 MIDI 設備編號設置為與
傳送時相同的值。 

 [UTILITY] → [Settings] → [Advanced] → MIDI “Device Number”   

當傳送無法正常工作時，連接至 MODX 的 MIDI 樂器設備編號是否與設備編號參數匹配？ 

 [UTILITY] → [Settings] → [Advanced] → MIDI “Device Number”   

無法將數據儲存至 USB 隨身硬碟。 

■ USB 隨身硬碟是否使用了寫保護？(要儲存數據，必須將寫保護設置為關閉。) 

■ USB 隨身硬碟上的可用空間是否充足？ 
在目錄畫面中，將設備設置為 USB 隨身硬碟。確認畫面右上方所示的 USB 隨身硬碟當前可用(未使用)的儲存量。 

 [UTILITY] → [Contents] → [Load]/[Store/Save]   

■ Yamaha 是否保證特定 USB 隨身硬碟的操作？ 
有關詳情，請參見第 61 頁。 

 

在畫面中，有一些黑點(未點亮)或白點(始終點亮)。 

■ 這些點是 LCD 螢幕偶發的壞圖素點；不影響操作。 
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技術規格 
鍵盤   MODX8：88 鍵，GHS 鍵盤(初始力度) 

MODX7：76 鍵，半配重鍵盤(初始力度) 
MODX6：61 鍵，半配重鍵盤(初始力度) 

音源模組 音源  動態控制合成引擎 
AWM2：8 元素 
FM-X：8 操作器，88 算法 

複音  AWM2：128 (最大；立體聲/單音波形) 
FM-X：64 (最大) 

多聲部能力  16 聲部(內建)，音頻輸入聲部(A/D*1，USB*1)  
*1 立體聲聲部 

波形  預置：5.67 GB (轉換為 16 位線性格式時)，用戶：1.00 GB 

演奏組  約 2,000 

濾波器  18 種類型 

效果系統  殘響 x 12 種類型，變化 x 85 種類型，插入(A、B) x 85 種類型*2，主
效果器 x 23 種類型  
*2 A/D 部分插入 x 80 種類型  
<各效果類型參數的預置設置以模板形式提供> 
主 EQ (5 頻段)，第一聲部 EQ (3 頻段)，第二聲部 EQ (2 頻段) 

音序器模組 音符容量  約 130,000 音符 

音符精度  480 ppq (每四分音符格數) 

速度(BPM)  5-300 

演奏組錄製器 樂曲 128 首樂曲 

音軌 16 音序音軌、速度音軌、場景音軌 

錄音類型 實時替換、實時疊加、實時切入/切出 

音序格式  MODX 原始格式、SMF 格式 0、1 

琶音 聲部 8 聲部同時(最大) 

預置 10,239 種類型 

用戶 256 種類型 

動態音序器 序列 8 + 1 序列(最大) 
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其它 現場設置  預置：256 以上，用戶：2,048 

控制器  主音量、AD 輸入增益旋鈕、USB 音量、彎音輪、調製輪 
控制滑桿 x 4、旋鈕 x 4、超級旋鈕、數據輪 

畫面  7" TFT 彩色寬屏 VGA LCD 觸摸屏 

接口  [USB TO DEVICE]、[USB TO HOST]、MIDI [IN]/[OUT]、 
FOOT CONTROLLER [1]/[2]、 
FOOT SWITCH [ASSIGNABLE]/[SUSTAIN]、 
OUTPUT [L/MONO]/[R] (6.3 mm，標準 phone 型插孔)、 
[PHONES] (6.3 mm，標準立體聲 phone 型插孔)、 
A/D INPUT [L/MONO]/[R] (6.3mm，標準 phone 型插孔) 

USB 音頻接口 採樣率 44.1 kHz 

通道 輸入：4 通道(2 個立體聲通道) 
輸出：10 通道(5 個立體聲通道) 

功耗  14W (整機) 
16W (整機和 AC 電源變壓器) 
(使用 PA-150B AC 電源變壓器時) 

尺寸、重量  MODX8：1,333 (寬) x 404 (深) x 160 (高) mm，13.8 kg 
MODX7：1,144 (寬) x 331 (深) x 134 (高) mm，7.4 kg 
MODX6：937 (寬) x 331 (深) x 134 (高) mm，6.6 kg 

附件  AC 電源變壓器(PA-150B 或 Yamaha*推薦的同等產品)、使用說明書
(本書)、Cubase AI 下載信息 
 
*根據特定地區不同，可能不含此物品。請諮詢 Yamaha 經銷商。 

 
* 本使用說明書的內容為出版時最新的技術規格。請至 Yamaha 網站下載最新版本的使用說明書。技術規格、設備

或選購配件在各個地區可能會有所不同，因此如有問題，請與當地 Yamaha 經銷商確認。 
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GNU GENERAL PUBLIC LICENSE 

GNU LESSER GENERAL PUBLIC LICENSE 

關於源代碼分發的註意事項 
在產品最終出廠後的 3 年內，您可以通過寫信到以下地址向 Yamaha 索取經 GNU General Public License 或 GNU 
Lesser General Public License 授權的本產品任何部分的源代碼。 
 

DMI Marketing Group、DMI Division 
Musical Instruments Business Division 
YAMAHA Corporation 
10-1 Nakazawa-cho, Naka-ku, Hamamatsu, 430-8650, JAPAN 

 
源代碼將免費提供，但是，本公司可能會要求您支付給 Yamaha 交付源代碼所需的成本。 
 請註意，本公司對於由 Yamaha (或 Yamaha 授權單位)以外的第三方對本產品的軟件所進行的變動(添加/刪除)而

造成的任何損失概不承擔責任。 
 請註意重新使用 Yamaha 發佈的不受專利權限制的源代碼是不允許的，而無論如何，Yamaha 不會承擔任何責任。 
 源代碼可從下列地址下載： 

https://download.yamaha.com/sourcecodes/synth/ 
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索引 
 

A 
A/D INPUT [GAIN]旋鈕 .............................................. 10 
A/D INPUT [L/MONO]/[R]插孔 ................................... 17 
A/D INPUT [ON/OFF]按鈕 ......................................... 10 
ABS (音頻節拍同步) .................................................. 17 
[ARP ON/OFF] (琶音開/關)按鈕 ..................................11 
[ASSIGN 1]和[ASSIGN 2]按鈕 
(可分配開關 1 和 2) .................................................... 10 
[ASSIGN]按鈕 ............................................................ 12 
[AUDITION]按鈕 ........................................................ 15 

B 
儲存 ........................................................................... 63 
封包跟隨器 ........................................................... 17, 46 
本機控制 .................................................................... 56 
比較功能 .................................................................... 42 
標記 ........................................................................... 25 
標準聲部(AWM2) ....................................................... 24 
標準聲部(FM-X) ......................................................... 24 

C 
[CATEGORY]按鈕 ..................................................... 15 
[CONTROL ASSIGN]按鈕.......................................... 13 
操作器 ........................................................................ 40 
操作器編輯 ................................................................. 40 
操作器通用編輯 ......................................................... 40 
層 ............................................................................... 43 
場景功能 .................................................................... 36 
場景選擇[1–4] [5–8]按鈕 ............................................ 12 
超級旋鈕 .............................................................. 13, 33 
撤銷 ........................................................................... 48 
觸摸面板 LCD ............................................................ 13 
初始出廠設置 ............................................................. 19 
初始化的演奏組 ......................................................... 27 
儲存 ........................................................................... 39 

D 
DAW (數位音樂工作站) .............................................. 58 
[DC IN] ....................................................................... 17 
[DEC/NO]按鈕 ........................................................... 14 
[ ] (待機/開機)開關 ................................................... 17 
單聲部演奏組 ............................................................. 24 
電源 ........................................................................... 18 
動態音序器 ................................................................. 30 
獨奏功能 .................................................................... 29 
多聲部演奏組 ............................................................. 24 

E 
[EDIT]按鈕 ................................................................. 14 
[ENTER]按鈕 ............................................................. 14 
[EXIT]按鈕 ................................................................. 14 
耳機 ........................................................................... 18 
 
 
 
 

F 
FM .............................................................................. 40 
FOOT CONTROLLER [1]/[2]插孔 .............................. 17 
FOOT SWITCH [ASSIGNABLE]/[SUSTAIN]插孔 ...... 17 
分割 ............................................................................ 44 
分類查找 .................................................................... 26 
分區 ............................................................................ 52 

G 
GM ............................................................................. 24 
GM 群組 ..................................................................... 24 
格式化 ........................................................................ 64 
鼓聲部 ........................................................................ 24 
游標按鈕 .............................................................. 14, 21 

H 
滑桿功能[PART]/[ELEMENT/OPERATOR]按鈕 ......... 12 
滑桿選擇[1–4] [5–8]按鈕 ............................................ 12 
畫面訊息 .................................................................... 66 
恢復 ............................................................................ 48 
混音 ............................................................................ 35 

I 
[INC/YES]按鈕 ........................................................... 14 

J 
加載 ............................................................................ 63 
鍵編輯 ........................................................................ 40 
鍵盤 ............................................................................ 10 
鍵通用編輯 ................................................................. 40 
節奏模式 .................................................................... 45 
節奏聲部 .................................................................... 45 
靜音功能 .................................................................... 29 

K 
KNOB POSITION [1]和[2]按鈕 ................................... 13 
控制滑桿 1–4 (5–8/9–12/13–16) ................................ 12 
控制器 ........................................................................ 31 
快速設置 .................................................................... 58 

L 
[LIVE SET]按鈕 .......................................................... 15 

M 
[MASTER VOLUME]旋鈕 .......................................... 10 
MIDI [IN]、[OUT]端口 ................................................ 17 
MIDI 端口 ................................................................... 59 
MIDI 發送通道 ............................................................ 57 
MIDI 接收通道 ............................................................ 57 
MIDI 錄音 ................................................................... 47 
MIDI 通道 ................................................................... 59 
[MOTION SEQ HOLD] (動態音序器保持)按鈕 ........... 11 
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[MOTION SEQ TRIGGER] 
(動態音序器觸發)按鈕 .................................................11 
[MS ON/OFF] (動態音序器開/關)按鈕 .........................11 
麥克風 ........................................................................ 53 

O 
OCTAVE [-]和[+]按鈕 ..................................................11 
OUTPUT [L/MONO]和[R]插孔 ................................... 17 

P 
[PART SELECT MUTE/SOLO]按鈕 ........................... 15 
[PERFORMANCE (HOME)]按鈕 ............................... 14 
[PHONES] (耳機)插孔 ................................................ 17 
Punch In/Out .............................................................. 48 
琶音 ........................................................................... 30 
琶音類型 .................................................................... 45 
頻率調製 .................................................................... 40 

Q 
啟動任務 .................................................................... 54 

R 
[RHYTHM PATTERN]按鈕 ......................................... 13 

S 
SCENE [1/5] [2/6] [3/7] [4/8]按鈕 ............................... 12 
SEQ TRANSPORT 按鈕 ............................................ 13 
[SHIFT] 按鈕 ............................................................. 14 
SSS (無縫聲音切換) .................................................. 25 
[STORE]按鈕 ............................................................. 14 
聲部編輯 .................................................................... 40 
聲部控制狀態 ............................................................. 32 
實時錄製 .................................................................... 47 
試聽樂句 .................................................................... 27 
數據輪 ........................................................................ 14 

T 
調製輪 ........................................................................ 10 
調製器 ........................................................................ 40 

U 
[USB TO DEVICE]端口 ........................................ 17, 64 
[USB TO HOST]端口 ........................................... 17, 59 
[USB VOLUME (MONITOR)]旋鈕 ............................. 10 
[UTILITY]按鈕 ............................................................ 14 

W 
彎音輪 ........................................................................ 10 

X 
現場設置 .............................................................. 25, 37 
現場設置畫面 ............................................................. 21 
效果 ........................................................................... 41 
旋鈕 ........................................................................... 32 
旋鈕 1–4 (5–8) ........................................................... 12 
旋鈕功能[TONE]/[EG/FX]/[EQ]/[ARP/MS]按鈕 .......... 12 
 
 
 
 
 

Y 
Yamaha Steinberg USB Driver .................................. 58 
演奏控制狀態 ............................................................. 32 
演奏組 ........................................................................ 24 
演奏組編輯 ................................................................. 39 
演奏組編輯畫面 .......................................................... 39 
演奏組播放 ................................................................. 28 
演奏組播放畫面 .......................................................... 21 
音軌 ............................................................................ 47 
音頻通道 .................................................................... 59 
元素編輯 .................................................................... 40 
元素通用編輯 ............................................................. 40 
用戶群組 .................................................................... 24 
預置群組 .................................................................... 24 
樂曲 ...................................................................... 47, 49 

Z 
載波 ............................................................................ 40 
在鍵盤上輸入 ............................................................. 22 
在數位鍵盤上輸入 ...................................................... 22 
主調音 ........................................................................ 55 
主音量 ........................................................................ 19 
自動關機 .................................................................... 19 
資料群組 .................................................................... 24 
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